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Der Beginn

BRM Lasers ist seit 2010 in der CO,-Lasermaschinenbranche aktiv, und zwar unter der
Leitung von Erik van Turnhout, dem ehemaligen Griinder von Tuwi
Metaalbewerkingsmachines (www.tuwi.nl). Mit gut 30-jahriger Erfahrung im Bau von
Metallbearbeitungsmaschinen waren wir auf der Suche nach Lasern, mit denen unter
anderem Materialien wie beispielsweise Acrylate und Holz geschnitten und graviert werden
kénnen. Unser Augenmerk fiel dabei auf den Import aus China, wobei Kontakte mit einer
vollig neuen Kultur und Welt gekniipft wurden. Der Beginn eines Abenteuers.

Mit unserer umfangreichen Erfahrung im Maschinenbau lieRen wir die Lasermaschinen so
anpassen, dass sie in allen Bereichen den niederlandischen Maf3stében entsprechen.
Sowohl qualitativ als auch in puncto Sicherheit. Fur uns hatte die Entwicklung eines Gerats,
das mit Stolz und guten Gewissens von BRM vertrieben werden kann, erste Prioritat. Dies
kostete einige Monate Zeit, doch so kdnnen wir nun schon seit geraumer Zeit sagen, dass
die BRM Lasermaschinen ein ausgezeichnetes Preis-Leistungsverhaltnis aufweisen und
schon Kunden aus ganz Europa tberzeugen konnten.

Die Entwicklung

Nachdem wir uns zu Beginn im kleinen Stil mit der Lasertechnik beschaftigt und
Demonstrationen in einem kleinen, gemieteten Geb&aude gegeben hatten, konnten wir im
vergangenen Jahr ein kraftiges Wachstum verzeichnen. So beschéftigt BRM ein Team
kompetenter Techniker zur Wartung der vielen hundert BRM Laser, die inzwischen in Betrieb
sind. Parallel zum Wachstum des Unternehmens selbst haben wir in Europa ein begeistertes
Vertriebsteam und Partnernetz aufgebaut. Dieses Netzwerk mdchten wir in den nachsten
Jahren weiter ausbauen, um letztendlich ganz Europa mit unseren Lasern bedienen zu
koénnen.

Die wesentlichen Pfeiler fur den weiteren Erfolg fiir BRM werden stets das genannte Preis-
Leistungsverhaltnis und der Service sein. Dies sind die Bausteine unseres Unternehmens,
deren Erhalt mit kontinuierlichen Erneuerungen gewabhrleistet sein wird. Wir Gberlegen gerne
gemeinsam mit Ihnen und beraten Sie selbstverstandlich freibleibend bezuglich der
Mdglichkeiten unserer Laser fir die von Ihnen gewlinschte Anwendung. Auch unser
technischer Service steht Ihnen rund um die Uhr, an 7 Tagen in der Woche zur
Unterstitzung zur Verfligung, sowohl vor als auch bei und nach dem Kauf und der Lieferung
einer BRM Laserschneidmaschine.
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Vorwort

Lesen Sie diese Bedienungsanleitung sorgfaltig, bevor Sie die Maschine

transportieren, installieren und in Betrieb nehmen.

Diese Maschine erfillt die geltenden europdaischen Richtlinien bzgl. der Sicherheit und

Gesundheit und ist mit einer CE-Kennzeichnung versehen.

Hersteller und Lieferant haften nicht fir Gefahrensituationen, Unfélle und Schéden infolge:
e der Nichtbeachtung von Warnungen oder Vorschriften laut den Angaben auf der

Maschine und/oder den Beschreibungen in dieser Bedienungsanleitung;

der Entfernung der angebrachten Sicherheitsvorrichtungen;

unzureichender Wartung und Pflege;

der Verwendung aulRerhalb der Beschreibung in Abschnitt 1.2, 1.3 und 1.4;

Anderungen an der Maschine durch Dritte. Darunter fallt auch die Verwendung

anderer als der vorgeschriebenen Ersatzteile und die Anderung des

Betriebssystem.

Diese Bedienungsanleitung enthélt relevante Informationen zur Installation, Nutzung,
Wartung, Reparatur. Diese Anweisungen missen ausgefiihrt werden.
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1 Einfuhrung

Die BRM Laserschneidmaschinen importiert BRM von HSG Laser.

1.1 Informationen Uiber den Maschinenhersteller und Importeur/Verantwortlichen zur
CE-Kennzeichnung

Hersteller: HSG Laser | =

Stral3e: Zhuijang Avenue 8

Ort: Foshan City ’ >
Land: China

E-Mail: info@hsglaser.com LASER =¥
Website: www.hsglaser.com
Importeur/
CE-Verantwortlicher: BRM Lasers
Strale: Ambachtstraat 43
PLZ: 7102 DW
Ort: Winterswijk LAS ER 5
Land: Niederlande brmlasers.com
Telefon: +31 (0)544-350320
E-Mail: Info@brmlasers.com
Website: www.brmlasers.com
3 -
Maschinenbezeichnung: BRM
Laserschneidmaschine
Modell: BRM 90130
Baujahr: 2015/07/20

Seriennummer; 91513909201
Netzanschluss: 220V-50Hz

Leistung: 2,5 kw
Laserleistung 100 W
Gewicht: 400 kg
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1.2 Vorgesehener Einsatzzweck der Maschine

Einsatzzweck der Lasermaschine ist das Brennen von Material mittels eines fokussierten
Lichtstrahls (Laserstrahls). Dabei wird auf niedriger Leistungsstufe eine Gravierung
ausgefihrt oder auf hoher Leistungsstufe ein Material durchschnitten.

Andere Verwendungen sind nicht gestattet.

Fur Schaden und Verletzungen durch andere als oben angegebene Verwendungen
und/oder durch die Uberbriickung von Sicherungen zahlt und haftet vollstandig der
Benutzer.

1.3 Nutzung von Laserstrahlung

Achtung:

Diese Lasermaschine enthalt ein Produkt der Laserklasse 4.
Vermeiden Sie die Exposition der Augen oder Haut an direkter oder
indirekter Strahlung.

Laser produzieren einen hohen, konzentrierten Lichtstrahl mit einer einzigen Frequenz.
Dieser unterscheidet sich von dem Licht, welches von einer herkdbmmlichen Lichtquelle
ausgesendet wird. Die vom Laserstrahl produzierte Energie wird in Hitze umgesetzt.
Laserbearbeitungen kénnen daher auch als ein Prozess gesteuerter Hitze angesehen
werden.

Das Licht eines Lasers ist konzentriert und bleibt selbst auf langer Entfernung in einem
dunnen Strahl, wahrend das Licht einer herkdbmmlichen Lichtquelle divergent ist. Aufgrund
dieses feinen, vom Laser produzierten Strahls kann die Maschine als effizientes und
hochwertiges Laserstrahlgerat angesehen werden.

Jede Form von Starklicht oder Hitze kann das menschliche Auge oder die menschliche Haut
durch Exposition in unterschiedlichen Formen schadigen. Daher muss sorgféltig mit dem
Geréat und eventuell reflektierenden Materialien umgegangen werden.

Laserbearbeitung
In 3 unterschiedlichen Situation hat der Laserstrahl keinen Effekt auf das bertihrte Material:

1) Materialien, die Laserenergie aussenden konnen, ohne sich selbst zu verandern,
beispielsweise Luft und bestimmte Kristalle.

2) Materialien, die fast die gesamte auf sie abgestrahlte Energie reflektieren kénnen.
Diese Materialien kdnnen fir optische Linsen oder Reflektoren verwendet werden.

3) Materialien, welche die Laserenergie absorbieren.
Dies sind Materialien, welche den Strahl absorbieren, jedoch thermische
Leiteigenschaften aufweisen, wodurch sie nicht durchschnitten werden kénnen.

Entzindliche Materialien

Entzindliche Materialien oder Gase entziinden sich unmittelbar bei Beriihrung mit dem
Laserstrahl, wodurch giftige Gase freigesetzt werden kénnen. Bei Erhitzung durchlaufen
einige Materialien (z. B. PVC) auch eine chemische Zersetzung, bei der ebenfalls gefahrliche
Stoffe entstehen kénnen. Wenden Sie sich an den Hersteller/Importeur, um
sicherzustellen, dass sich das zu bearbeitende Material fir die Laserbearbeitung
eignet.
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1.4 Mogliche Materialien zur Bearbeitung durch BRM Laser

Legenda

‘“ Lear peschikt voor laserbewerking
! Beperkt geschikt voor laserbewerking

x Miet geschikt woor laserbewerking

Materiaal Laser snijden Laser graveren
Filten foam 4 1
Glas en spiegels % =
Haout g EJ/
Karton en hardboard 4 4
keramiek en porselein » 4
Kurk 4 4
Leer & 1
MDF 4 v
Multiplex 4 E{
Natuursteen, graniet en marmer » W
Pakkingen 4 !
Papier 1 4
Textiel 4 4
Trespa % T
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Materiaal - Kunststoffen Laser snijden Laser graveren

Acrylics, Plexiglas, PMMA (v 4
‘Vergelijkbare produkten

Acrylic glass, Acrytuf®, Altuglas®, Astralon &®, Casocryl®, Degalan®, Deglas®, Dunova’®, Friacryl®, Hesa-Glaz®, Limacoryl®, Lucite®,

Lucryl®, Paraglas®, Perspex®, Plexiglas®, Polymethyl-methacrylat (PMBMA), Primal®, Resarit®

Aramide 4 b4
‘Wergelijkbare produkten

Aramide, Aramid fiber, Aramid tissue. Nomex®, Kevlar®, Teijinconex®, Twaron®, PTPA, Aromatic polyamide, Aramid fiber type, Aramid
panels.

PETG, VIVAK g

Polyamide (PA) 4
‘Vergelijkbare produkten

Dederon®, Grilon®, Mylon, Perlon®, Akulon®, Timbrelle®, Rilsan®, Ultramid®, Durethan®, Trogamid TE, Yestamid'®, Stanyd®,
Ertalon®, Ripstop Mylon.

Polycarbonaat, Makrolon, Lexaan 1 b4

Vergelijkbare produkten
Anjacony®, Anjaflam®, Anjalon®, Awxxiz®, Decarglass, Durolon®, Latilon®, Lexar®, Makrofol®, Makrolon®, Polycarbonate, Xantar®

Polyester E !
Vergelijkbare produkten

Fleece®, PES, Polarguard®, Polyester, Thermolite®, Trevira®.

Polyethylene, Hostalen,Vestalen, Lupolen B !

Vergelijkbare produkten
PE. Polydthylen, Polyethen, Alathond®, Dyneema®, Hostalen®, Lupolen®, Polythen®, Spectra®, Trolen®, Vestolen®, Luflexen®,
Bayloni®.

Polyimide, Kapton B B

Vergelijkbare produkten
Paolyimide, PI, Kaptor®, NortonE TH polyirmide film.

Polyoxymethylene, POM B

‘Wergelijkbare produkten
Polyaceta, Polyformaldehyd. Ultraformé@®, Delrin®, Hostaform@, Ertacetal ®.

Polypropylene B B

‘Wergelijkbare produkten

PP, Inspire®, Nepol®, Xmod®, Bicor®, Hicor®, Vestolen PE, Polyfill®, Topilens®, Eltex®, Sequel®, Ontex®, Tatren®, Novolen®,

Profax®.

PUR B B

‘Vergelijkbare produkten
Cellasto®, Elastocoat®, Elastoflex®, Elastofoam®, Elastolit®, Elastopal®, Elastopan®, Elastopor®, Lupranol®, Baydwr®, Bayfill @,
Bayflex®, Bayliv®, Baymer®, Baytherm'®, Desmodur®

Styrene-acrylonitrile, SAM E,,
‘Wergelijkbare produkten

SAN, Luran®, TyrikE, Kostil®, Vestyron®, Lustran®.

Polystyrene B b4

Vergelijkbare produkten
Paolystyrene, P5, Hostyren®, Vestyron®, Styropor®, Hostapor®, VestyporE,
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Materiaal - Metaal Lasersnijden Laser graveren

Lasersnijden alleen mogelijk met de BRM Metaalsnijder tot op 1.2mm. Dit geldt cok alleen voor staal en RVS-types.

Daarnaast gravures mogelijk met enerzijds de Fiberlaser of anderzijds de C02 machines, waarbij bij laatsgencemde Cermark spray

tsge!

nodig is woor een zichthare markering.

Aluminium b 4 E,/

Edelmetalen X E,/

Platina, Goud, Zilver, Rhadium, Csmiuwm, Palladium, Iridium, Ruthenium

\|zer, Koper, Nikkel en Zink x 4

Legeringen b 4 E,/

Alpaca, Brons, Constantaan, Invar, Mangaanstaal, Messing

Staal en RVS

«
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1.5 Ubersicht der Hauptkomponenten

Die Lasermaschine enthdlt die folgenden Hauptkomponenten

Maschinengehause

Laserraumdeckel

Laserraum

X-/Y-Achse mit Laser

Bedienfeld auf der Oberseite

Notaustaster

Hauptschalter mit diversen Optionen fir externe Anschlisse
Schaltschrank

Wartungsraum rechts

10. Wartungsraum links

11. Laserresonatorraum

12. Netzteilraum

13. Kiihlwasseranschlussfeld

14. Anschluss fur die Absaugung

15. Anschlussfeld fiir Netzteil, Netzteilkabelanschluss (geerdeter Eurostecker), Netzteil
240V-60Hz/Erdung + 2 geschaltete Steckdosen 240V-60Hz/Erdung

©CONoOOALONE
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Y-Achse (vorne - hinten)

X-Achse (links-rechts)

Z-Achse (0ben-unten)

Linke Seite Rechte Seite
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1.6 Erlauterungen zu den Hauptkomponenten und allg. Beschreibung der
Lasermaschine

Allgemeine (Funktions-) Beschreibung der Lasermaschine

Die Lasermaschine brennt durch einen fokussierten Lichtstrahl (Laserstrahl) in oder durch
ein Material. Dabei wird auf niedriger Leistungsstufe eine Gravierung ausgefiihrt oder auf
hoher Leistungsstufe ein Material durchschnitten. Der Laserstrahl wird mittels einer CO2-
Quelle erzeugt und hat eine Wellenlange von 1064 nm. Die Wellenlange kann einen
positiven oder negativen Effekt auf Materialien haben, was bedeutet, dass einige Materialien
nicht graviert oder geschnitten werden kénnen. Dies muss berticksichtigt werden.

Da der Laserstrahl brennen kann, ist die Uberbriickung von Sicherungen nicht
gestattet.

2 Transparenter Deckel

Der transparente Deckel dient zum Verschliel3en des Laserraums. Nach dem Schlie3en des
Deckels wird ein Magnetkontakt hergestellt und die Maschine kann gestartet werden.

Beim Offnen des Deckels hilt das Gerat abrupt an.

3 Laserraum
Dies ist der (verschlossene) Raum, in dem der Laserstrahl das Material zur Herstellung des
gewilnschten Produkts berihrt.

4 X-IY-IZ-Achse mit Laser
Der Laserstrahl wird mittels einer mechanischen Konstruktion an die entsprechende Stelle
gefahren, die durch die Software automatisch gesteuert wird.

Diese Konstruktion wird "XYZ-Portal" genannt.

Laserkopf mit links und rechts
herausragenden Fihrungen

5 Bedienfeld auf der Oberseite
Das Bedienfeld wird zur Produktionsvorbereitung benutzt.
Nach der Vorbereitung des Produkts auf dem PC und dem
Download des Programms zur Maschine kann die
Produktion mithilfe dieses Felds vorbereitet, gestartet und
nachverfolgt werden. Falls notwendig, kénnen auch
Feinkorrekturen ohne Zuhilfenahme eines PCs

durchgefuhrt werden.

6 Notaustaster QGENCY ¢
Durch Drucken des Notaustasters werden die Antriebe und die & 2,
Laserquelle vollstandig ausgeschaltet und spannungslos gemacht. Die
Antriebe/Fihrungen sind manuell verschiebbar. oa &
Siehe Abschnitt 4.8, Start nach einer Notausschaltung. S 4on20%
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7 Hauptschalter mit diversen Optionen fir externe Anschlisse
Funktionen siehe Abschnitt 3.4.

A PR R 4

Hauptschalter

Hauptschalter
Lasernetzteil
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2 Verantwortlichkeiten und Sicherheit

2.1 Verantwortlichkeiten

Lesen Sie zuerst die Bedienungsanleitung, bevor Sie mit der Installation, Bedienung,
Wartung oder Reparatur der Maschine beginnen.

Diese Bedienungsanleitung enthélt fiir eine optimale und sichere Bedienung und Wartung
der Maschine erforderlichen Informationen.

Ohne Zustimmung des Herstellers dirfen keine Anpassungen/ Anderungen an der
Maschine durchgefuhrt werden.

Durch Anpassungen und Anderungen verliert die CE-Zertifizierung ihre Gultigkeit und
die Sicherheit kann ernsthaft gefahrdet werden.

Die Maschine kann nur von einer Person gleichzeitig bedient werden.
Die Maschine darf ausschlie3lich von geschulten Mitarbeitern bedient werden.

Installations-, Wartungs- und Reparaturarbeiten dirfen ausschlief3lich von dazu
ausgebildeten Mitarbeitern durchgefihrt werden.

2.2 Laserstrahlung

Achtung:

Diese Lasermaschine enthalt ein Produkt der Laserklasse 4.
Vermeiden Sie die Exposition der Augen oder Haut an direkter oder
indirekter Strahlung.
Die Laserquelle darf ausschlie3lich von einem dazu ausgebildeten Techniker
ausgetauscht werden.
Beim Austausch der Laserquelle muss das Gerat ausgeschaltet und der
Schlusselschalter gesperrt sein. Ferner muss der Netzstecker aus der Steckdose
gezogen werden.

Ergreifen Sie die folgenden SicherheitsmalRnahmen:

e Schauen Sie nicht direkt in den Laserstrahl. i j
o Vermeiden Sie unngtige Reflektionen. \_‘?

e Tragen Sie bei der Arbeit mit dem Laser eine Schutzbrille.

e Vergewissern Sie sich, dass Feuerldscher in greifbarer Nahe n sind.

e Schalten Sie den Laser aus, wenn nicht mehr mit ihm
gearbeitet wird.

e Verteilen Sie die zu bearbeitenden Einheiten. Achten Sie auch auf entziindlichen
Restabfall.

e Legen Sie kein Papier oder andere entflammbaren Objekte in der Nahe des
Laserwegs.

e Benutzen Sie die Maschinen nicht bei Gewitter und Blitzschlag. Schalten Sie den
Strom in diesem Fall aus.

Datum:09-04-16 Seite: 1A0n 121



Bedienungsanleitung Laserschneidmaschine BRM 90130 Version 2

2.3 Sicherheitsvorrichtungen

Zur Vermeidung von Klemm-, Quetsch- oder andere Gefahren wahrend der Nutzung und zur
Gewahrleistung einer sicheren Bedienung wurden verschiedene MalRnahmen getroffen. Die
angebrachten Vorrichtungen dirfen ausschlief3lich von einem dazu befugten Techniker fur
Wartungs- oder Reparaturzwecke und nur, wenn es unbedingt erforderlich ist, entfernt
werden.

Prifen Sie, ob die Sicherheitsvorrichtungen wieder angebracht wurden, bevor der
Hauptschalter eingeschaltet wird und die Maschine wieder in Betrieb genommen wird.

An der Maschine sind die folgenden Sicherheitsvorkehrungen angebracht:
e Diverse Piktogramme, siehe Abschnitt 2.3 und 2.4.
e Die Maschine ist mit einem Netzkabel mit Eurostecker
und Erdung ausgestattet und muss an eine dazu

geeignete Steckdose mit einer Netzspannung von 240V-
50/60Hz/Erdung angeschlossen werden.

e Der transparente Deckel schirmt den Laserraum wahrend des Betriebs ab. Durch das
SchlieRen des Deckels wird mittels eines Magnetschalters das Gerat zum Start
freigegeben.

Beim Offnen des Deckels halt das Gerat abrupt an.

Datum:09-04-16 Seite: 18von 121



Bedienungsanleitung Laserschneidmaschine BRM 90130 Version 2

e An jeder Zugangsoffnung/Klappe rundum das Gerét sind Magnetschalter angebracht.
Beim Offnen einer dieser Offnungen/Klappen hélt das Geréat abrupt an.

e Signalleuchte Laser in Betrieb

e Notaustaster
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e Diverse Sicherheitshinweise

BERMLASERS

Tl L

Onzichtbare Laserstraling
Vermijd blootstelling van ogen of huid
aan directe of indirecte straling

Klasse 4 laserproduct
|EC 60825-1:2007

Blijf bij de machine tijdens
bedrijf i.v.m. mogelijk
brandgevaar. Schakel de
machine uit alvorens deze
onbeheerd achter te \aten.
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2.4 Verwendete Piktogramme

Gefahrenhinweise

Die laser anlage erzeugt eine unsichtbare laserstralung.

Schutzen sie ihre augen und ihre haut vor der
Direkten und auch indirekten laserstralung.

AChtung: Die anlage entspricht einer
Gefahr durch Laserstrahlu ng Laserklasse 4 EN-IEC 60825-1:2014

Achtung: Warnung vor Handverletzungen durch
Quetschgefahr

Achtung: Einzugsgefahr der Finger

Achtung: Elektrische Spannung

Achtung: Hochspannung 30.000-55.000V)

Hochspannung
Lebensgefahr

Bitte schalten sie die machine aus

A wenn sie den raum verlassen und
. die anlage nicht beobachten
AChtung- Feuergefahr kénnen, auf grund erhéh te
brandgefahr. Niemals der anlage
) ohne aufsicht betreiben

Achtung: Allgemeine Gefahr

4 d dd

Verbotshinweise

Offnen wahrend des Betriebs verboten

W

Offnen wahrend
des Betriebs
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2.5 Verwendete Piktogramme an moglichen Gefahrenorten auf der Maschine

Pos 01 Achtung:
Allgemeine Gefahr wéahrend des
{ : Betriebs bei Reparatur und Wartung.
Q '
N

Pos. 02 Achtung:

Laserstrahlung bei in Betrieb
befindlichem Laser bei Reparatur und
Wartung.

A

Pos. 03 Achtung:

Quetschgefahr fur Finger und Hande am
Endanschlag der X- und Y-Achse in linker
Reparaturluke wahrend des Betriebs bei
Reparatur und Wartung.

Pos. 04 Achtung:

Laserstrahlung bei in Betrieb befindlichem
Laser in linker Reparaturluke bei Reparatur
und Wartung.

Pos. 05 Achtung:

Quetschgefahr fur Finger und Hand am
Endanschlag der X- und Y-Achse in
rechter Reparaturluke wahrend des
Betriebs bei Reparatur und Wartung.

-

Pos. 06 Achtung:

Pos. 07 Achtung: Laserstrahlung bei in Betrieb befindlichem
Elektrische Spannung bei Laser in rechter Reparaturluke bei Reparatur
eingeschalteter Maschine bei Reparatur und Wartung.

und Wartung.
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Pos.8 + 9 Achtung:
Hochspannung im
4 Laserresonatorraum und ~ Laserresonatorraum bei
Lasernetzteilraum bei eingeschalteter bemd cingeschalteter Maschine bei
Maschine bei Reparatur und Wartung. Reparatur und Wartung.

Pos.10 Achtung:
Laserstrahlung im
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Pos.10 Achtung:
Laserstrahlung im
Laserresonatorraum bei
eingeschalteter Maschine bei
Reparatur und Wartung.

/

\

\

Pos.11 bis 14 Achtung: Pos. 15 bis 18 Achtung:
, Quetschgefahr fir Finger und Hand am Endanschlag Einzugsgefahr fur Finger und Hand am
der X-/Y-Achse an beiden Seiten wéhrend des Zahnriemen der X-/Y-Achse an beiden Seiten
wahrend des Betriebs bei Reparatur und

Betriebs bei Reparatur und Wartung.

\Aartiinn
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Pos. 21 Achtung:

Quetschgefahr fur Finger und Hand
a. d. hinteren Position der Y-
Achsen-Fihrung wahrend des
Betriebs bei Reparatur und Wartung.

Pos. 19 Achtung:

Laserstrahlung bei in Betrieb
befindlichem Laser bei Reparatur und
Wartung.

A

Pos. 20 Achtung:

Quetschgefahr fur Finger und Hand
am Endanschlag links und rechts
des Laserhalter wahrend des
Betriebs bei Reparatur und Wartung.
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3 Installation

Beachten Sie die folgenden Punkte:
e Uberprifen Sie die Maschine und das Netzkabel auf Beschadigungen.
e Stellen Sie sicher, dass das Kabel nicht gequetscht wird.
e Verwenden Sie die Maschine nicht in Wassernéhe.
¢ Stellen Sie die Maschine auf einen stabilen Untergrund, eine Werkbank oder einen
Tisch.
Alle Offnungen in und rund um die Maschine tragen zur Belliftung der Maschine bei.
e Stellen Sie sicher, dass all diese Offnungen frei bleiben.
¢ Stellen Sie die Maschine nicht in der Nahe einer Heizung oder anderen Warmequelle
auf.
e Sorgen Sie fir eine staubfreie Umgebung.
e Die Maschine bendtigt 1 separaten Stromkreis, an den keine anderen Geréten
angeschlossen sind.

Eventuelle Korrekturen/Anderungen in den Einstellungen der Maschine miissen von
oder in Rucksprache mit BRM Lasers durchgefuhrt werden.

Der Laser besitzt diverse Anschlisse fur Gerate, die mit der Maschine verbunden sein
miussen. Dies sind:

e Kihler fir das CO2-Rohr

e Luftkompressor

e Absaugung oder Bofa Absaug- und Filteranlage fur die Absaugung der Laserdampfe
Ferner besitzt der Laser noch Anschliisse fir:

e PC

e Ethernet

e Maus

e USB-Stick

Bei einem Metalllaser befindet sich auch ein Oz-Anschluss fir die Sauerstoffflasche am
Gerat.

3.1 Kilhlanschluss

Der Kihler muss mit 2 Schlduchen und 1 Alarmkabel angeschlossen werden. Der
Wasserauslass des Lasers wird an dem Wassereinlass des Kiihlers angeschlossen,. Der
Wasserauslass des Kuhlers wird wiederum am Wassereinlass des Lasers angeschlossen.
Hiermit wird ein Kihlwasserkreislauf geschaffen. Der Kihler kiihlt das Wasser und pumpt es
durch den Schlauch zum Laserrohr. Im Laserrohr nimmt das Wasser die Warme des Rohrs
auf, sodass das Rohr kihl bleibt. AnschlieRend stromt das warme Wasser aus dem Rohr
wieder zum Kdihler.

Wasserauslass der Lasermaschine
zum Wassereinlass des Kihlers

Wasserauslass des Kihlers zum
Wassereinlass der Lasermaschine
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Das Alarmkabel fihrt vom Kihler aus zum Laser, es sendet ein Signal, dass der Kihler
funktioniert. Wenn der Schlauch gequetscht wird oder der Kiihler aus einem anderen Grund
keine ausreichende Kuhlleistung erbringt, stoppt die Signalsendung und der Laser schneidet
aus Sicherheitsgrinden nicht.

3.2 Kompressoranschluss

Der Kompressor wird zur Schaffung eines konstanten Luftstroms entlang der Schnittlinie des
Lasers bendtigt. Dies ist aus mehreren Griinden wichtig. Der Luftstrom gewahrleistet, dass
die Lasergase nicht am Laserkopf verbleiben, was die Gefahr der Entziindung der Lasergase
verringert. Der Luftstrom verringert ebenfalls die Verdunkelung vor dem Laserstrahl, wodurch
die Schneidleistung des Lasers verbessert wird. Ferner erzeugt der Luftstrom ausreichende
Kihlung und Abfall wird weggeblasen.

(=3
&
)
or
o
<
-4

Der Kompressor erhalt seinen Strom aus der Steckdose auf der Riickseite der
Lasermaschine.

Dort befindet sich auch der Luftzufuhranschluss. Wenn der Kompressor an der Steckdose
und Luftzufuhr angeschlossen ist, wird die Luft intern in der Maschine zum Laserkopf geflhrt.
Am Laserkopf befindet sich ein Ventil zur Beistellung der Luftmenge. Evtl. kann eine
Nachjustierung des Ventils zu einem besseren Resultat fithren.

Datum:09-04-16 Seite: 27Ao0n 121



Bedienungsanleitung Laserschneidmaschine BRM 90130 Version 2

3.3 Anschluss der Absaugung oder Bofa Absaug- und Filteranlage

Die Lasermaschine muss an eine Luftabfuhrvorrichtung angeschlossen werden, um die
Lasergase aus dem Laserraum abzufiihren.

Bei Verwendung eines Absaugventilators kann dieser auf einer zentralen Absauganlage
angeschlossen werden, ansonsten kann die Luft auch direkt nach auf3en geleitet werden.
Wenn keine (zentrale) Absaugung nach aufRen mdglich ist, wird empfohlen, eine separate
Bofa Luftabsaug- und Filteranlage (hachfolgend "Bofa Anlage" genannt) anzuschlieRen.
Beide nutzen dieselben Anschlisse zur Lasermaschine.

Uber den Luftanschluss mittig hinten unter der Maschine kann die Absaugung oder Bofa
Anlage mit dem Laser verbunden werden. Der Stromanschluss fir die Absaugung oder Bofa
Anlage wird von einer Steckdose (EU 230/240V 50/Hz) hinten an der Maschine geliefert.

Vergessen Sie nicht, den Ein-/Ausschalter der Bofa Anlage im Gebrauchsfall auf Ein zu

Luftanschluss
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3.4 PC-, USB-, Maus- und Netzwerkmausanschliisse

Auf dem seitlichen Bedienfeld der Lasermaschine befinden sich die Sekundarschalter und
diverse Anschlisse.

Es sind 3 USB-Anschlisse vorhanden. Der PC-Anschluss muss unmittelbar mit dem PC
verbunden werden, wenn Befehle direkt vom PC-Programm aus an die Maschine erteilt
werden mussen. Uber den USB-Port kénnen USB-Sticks angeschlossen werden und
Programme ohne Anschluss eines PCs installiert und verwendet werden. An einem
Mausanschluss kann eine Maus angeschlossen werden, die fur das Dialogfenster im
Bedienfeld benutzt werden kann. Dies ist jedoch optional. Die Maschine kann vollstandig
ohne angeschlossene Maus genutzt werden. Die Bedienung mittels Maus kann jedoch evtl.
als angenehmer empfunden werden.

Die Maus kann also angeschlossen werden, aber die Maschine kann, wie erwahnt,
vollstdndig ohne angeschlossene Maus genutzt werden Mit dem Netzwerkanschluss kann
die Maschine Uber das Netzwerk an den PC angeschlossen werden. Bzgl. des Aufbaus einer
Internetverbindung siehe Kapitel 5 Software.

Maschinenhauptschalter
Milliamperemesser zur
Kontrolle der

Schalter zum Ein- und aufgenommenen Leistung

Ausschalten der Steckdosen auf
der Rickseite

Milliamperemesser zur
Kontrolle der
aufgenommenen Leistung,
Rohr 2

Schalter zum Wechsel
zwischen Y- und U-Achse

Resettaste des

Hauptschalter fur den
Notaustasters

Netzanschluss des Lasers
2

Hauptschalter fur den
Netzanschluss des Lase

Netzwerk-, USB-, Maus-
und PC-Anschlisse

Leistungsregler,
automatische oder
manuell

Potentiometer zur
manuellen Regelung der
Laserleistung, Rohr 2

Potentiometer zur Leistungsregler,
manuellen Regelung a@utomatisch oder manuell,
der Laserleistung Rohr 2

Wenn alle erforderlichen Verbindungen hergestellt wurden, kann die Maschine gestartet und
eingestellt werden. Siehe Kapitel 6 Einstellung
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3.5 Installation der Software

Zur Steuerung des Lasers muss Software installiert werden, die Zeichnungen und
Abbildungen, die ausgeschnitten oder graviert werden sollen, fiir den Laser vorbereitet.
Diese Software wird mit der Maschine zur Installation auf einem bestehenden PC geliefert.

{%] RDCANE. 0. 01 Install [B[EES]

Welcome to the RDCAM Setup Wizard

Wenn Sie das Installationsprogramm starten, wird das
nebenstehende Fenster sichtbar. Klicken Sie hier auf

This wizard will guide you throuah the installation of RDCAM, In S tal I .

Il etk vou e e pplatire b st ot T Wahrend des Ladens der erforderlichen Dateien wird
computer. . - .
oo ein Ladebalken angezeigt. Nach dem erfolgreichen

Ladevorgang wird ein Fenster mit diversen
Auswahlméglichkeiten angezeigt.

j Cancel

Imistall USE l

Mit den oberen 2 Tasten kdnnen USB-Treiber installiert oder
deinstalliert werden.
Diese missen zuerst installiert werden, bevor der

Install USE driwver

Type: Laserfork w . ] )

LYP . simLity e «| | €19€Ntliche Installationsvorgang fortgesetzt werden kann.
Anguage . . N M . .
Meinboard. s B Nach dieser Installation sehen Sie ein Auswahlfenster, in

dem Sie die Software auswéahlen kénnen.

I:lLocate install path
I:lPen drawing lines

D]]emo version

| sl || Exit

Typ

Hier wahlen Sie aus, ob Sie die Software installieren mochten, oder Sie wahlen einen Plug-in
fur ein anderes Zeichenprogramm. Mit einem Plug-in kénnen Sie das andere
Zeichenprogramm zur Erstellung von Laserdateien verwenden. Das CorelDRAW Plug-in
unterstitzt CoreIDRAW 11 bis x5 und das AutoCAD Plug-in unterstitzt die Version 2004 bis
2010.

Sprache
Im Auswahlmenii wahlen Sie die Sprache aus, welche Sie installieren méchten.

Mainboard
Ist voreingestellt und braucht nicht verwendet zu werden.

Locate install path

Dient dazu, einen anderen Installationsort zu verwenden. StandardméaRiger Installationsort ist
CA

Pen drawing lines
Ist nur bei einem bestimmten Maschinentyp erforderlich und braucht normalerweise nicht
aktiviert zu werden. Sollte dies wohl der Fall sein, weist BRM darauf hin.

Plug-in laserwork
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Dies installiert spezielle Plug-ins zur Anwendung erweiterter Funktionen mit der Software,
wenn Sie sich sehr gut mit der Software auskennen, kann dies eine schéne Erganzung sein.

Installation einer Demoversion

Hiermit kann eine Demoversion installiert werden. Diese funktioniert ohne Verbindung zu
einem Laser und ist daher praktisch, um sich mit der Software vertraut zu machen. Es kann
jedoch kein Programm zur Maschine gesendet und gespeichert werden.

Wenn alle Auswahlen getroffen wurden, kann Install angeklickt werden, und die aktuelle
Konfiguration wird installiert. Wenn die Installation erfolgreich abgeschlossen wurde, werden
Sie mit einem Fenster Install finish! begrift.

Das Installationsauswahlfenster schlief3t nicht automatisch ab, sodass eine zusatzliche
Installation konfiguriert werden kann. Wenn Sie z. B. das AutoCAD Plug-in und Laserwork
selbst installieren mdchten, kdnnen Sie die Installation 2x mit unterschiedlichen Auswahlen
durchfuhren.

Wenn alle Installationen abgeschlossen sind, klicken Sie auf Exit und die Software ist
erfolgreich installiert.
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4 Bedienungsanleitung (Steuerunq)

Die Bedienung ist ausschlie3lich geschulten Mitarbeitern gestattet.

Uberpriifen Sie vor der Nutzung der Maschine, dass sich kein Schmutz und/oder
Gegenstande in/auf der Maschine befinden.

4.1 Bedienfeld

LASER CONTROL SYSTEMS

1 2 3
RuiDe ACS
RD320-N Control System 7 8 9
system is reseting, please wait...
0 . CL

i — Z+ Y+ Enter
- Origin goasg Frame' Menu :
= - (HOME) X+
Laser| speed| Ul l:g\av:r File Z- Y- Esc

4.2 Bedientasten

“‘Reset’-Taste .: setzt das gesamte System zuriick und fahrt den Nullpunkt an;

Origin
“Origin”-Taste . legt den aktuellen Standort als Arbeitsnullpunkt fest;

Laser
“Laser’-Taste . erzeugt einen Impuls;

Frame
“‘Frame”-Taste : folgen Sie dem auf3ersten Rahmen des ausgewahlten Programms,

um zu kontrollieren, ob er korrekt positioniert ist;

File
“File”-Taste . zur Datei- und Programmverwaltung;

speed
“Speed”-Taste . stellt die Geschwindigkeit fur die Bewegungstasten und der aktuell

ausgewahlten Schicht ein;
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Max
Power

“Max Power’-Taste : stellt die Leistung des Laserkopfes und die Hochstleistung bei

der aktuell ausgewdahlten Schicht ein;

Min:

Power
“Min Power”-Taste : stellt die Mindestleistung bei der aktuell ausgewahlten Schicht
ein;

Stop
“Stop”-Taste .——_J:stoppt die aktuelle Bearbeitung;

prem—

Start

Pause . . .
“Start/Pause”-Taste “——_/:startet oder unterbricht die aktuelle Bearbeitung;

K= || X+

“X+/-"-Taste : Links-/Rechtsbewegung im Menl oder der x-Achse;

Y-
“Y+/-”-Taste A : Aufwarts-/ Abwartsbewegung im MenU oder der Y-Achse;

ik
“Z+/->-Taste : Bewegung der Z-Achse oder Blattern im Men;
HOME

‘HOME”-Taste :Meni zum Anfahren des Nullpunktes 6ffnen

Menu
“Menu”-Taste :Zu den Menueinstellungen gehen;

diag

. nDSE - - .
“‘Diagnose”-Taste :Systemdiagnose wie z. B. Wasserkuhler usw.;
Esc

“Esc’-Taste : stoppt die Arbeit und schlie3t das gedffnete Mend;

“Enter’-Taste

Emter
: vorgenommene Anderungen annehmen;

“Ziffern”-Taste 0 .. 9 :zur Eingabe in den Eingabefenstern;

“Dot’-Taste

“CL"-Taste

:Setzen eines Punktes in das Eingabefeld;

cL
:Feldeingabe l6schen;
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4.3 Schnittstelle

4.3.1 Hauptmenu

Wenn die Maschine hochgefahren und der Nullpunkt angefahren wurde, wird nachfolgendes

Fenster angezeigt:
Dateinummer
Arbeitsgeschwindigkeit

Hoéchstleistung des
Lasers

1

Pow 12.3%/22. 3%

Vorschauflache File 001
K\ Spd- 1200mmf S ]

X-, Y-, Z-Koordinaten

Systemstatus Schicht-Information

Zeit und Datum

N -

1dle Count:15

¥ 7-';‘_' l 09:233 <
» o0sz.1 0

—_—

Arbeitsnummer

Netzwerkstatus

{

e Vorschauflache
Hier wird eine optische Vorschau des geladenen Programms wiedergegeben.

e Systemstatus
Wiedergabe des aktuellen Status

e Arbeitsnummer
Wie haufig das aktuelle Programm gelaufen ist

e Netzwerkstatus
Anzeige der Internetkonnektivitat

e Zeit u. Datum Daten
Zeit u. Datum Anzeige

e Schichtinformation
Anzeige, welche Schichten sich in Auftrag befinden Doppelklicken Sie auf "Enter”, um
in die Schichteinstellungen zu gelangen und Anpassungen an die Geschwindigkeit
und Leistungen vornehmen zu kénnen.

e X-Y-Z-Koordinaten
Den aktuellen Ort des Laserkopfes akkurat bis auf 0,1 mm wiedergeben

e Hochstleistung des Lasers
In ‘idle" wird hier die Laserkopfleistung wiedergegeben. In Running/Pause wird hier
die Leistung der aktuellen Schicht wiedergegeben.

e Arbeitsgeschwindigkeit
In ‘idle’ wird hier die eingestellte Geschwindigkeit fir die manuelle Bedienung
wiedergegeben. In Running/Pause wird hier die aktuelle Geschwindigkeit der
Schichtbearbeitung wiedergegeben.

e Dateinummer
Die Dateinummer in der Dateiverwaltung
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4.3.2 Geschwindigkeit &ndern

Dricken Sie auf "Speed"”, wenn Sie sich im Hauptmeni befinden. Das folgende Dialogfenster
erscheint:

Driicken Sie die Taste "X+/-" und verschieben Sie den Cursor dadurch nach links und rechts.
Driicken Sie die "CL"-Taste, um den alten Wert zu entfernen. Driicken Sie die "Numeral"-
Taste, um den Wert in den gewiinschten Wert zu andern. Driicken Sie die "Enter"-Taste, um
die Anderung zu speichern. Driicken Sie die "Esc"-Taste, wenn Sie die Anderung nicht
speichern mochten.

4.3.3 Hochst-/Mindestleistung andern

Driicken Sie die "Max Power"- oder die "Min Power"-Taste, wenn Sie sich im Hauptmeni
befinden, das folgende Dia_Iogfenster erscheint;

MaxPowerl 80.5 =
MaxPower2: 75.9] =
[ Ok ] l Exit ]

Diese Anderung wird genauso wie die Anderung der Geschwindigkeit durchgefiihrt.

4.3.4 Nullpunkt anfahren

Dricken Sie die "Home"-Taste, wenn Sie sich im Hauptmeni befinden. Das folgende
Dialogfenster erscheint:

Datum:09-04-16 Seite: 35von 121



Bedienungsanleitung Laserschneidmaschine BRM 90130 Version 2

Dricken Sie die “X+/-“-Tasten, um den Cursor zu verschieben. Driicken Sie "Enter”, um den
ausgewahlten Achsennullpunkt anfahren zu lassen. Das Dialogfenster gibt eine Meldung,
wenn der Nullpunkt anféahrt.

4.3.5 Schichteinstellungen anpassen

Nachdem ein Programm ausgewahlt wurde, kénnen Sie die "Enter"-Taste zur Auswahl der
ersten Schicht verwenden. Danach kénnen die Tasten “Z+/-” zur Auswahl einer anderen
Schicht verwendet werden. Wenn die gewiinschte Schicht ausgewahlt wurde, driicken Sie
"Enter" zur Offnung des Dialogfensters Schicht. Das Dialogfenster sieht wie folgt aus:

\

%Layer: v
%S];eed: 00 nm
%Laser: 1 v
\Max power: 805 %
M power: 21.6 %

l

[ Exit |( Ok |
|

Dricken Sie die Tasten "Z+/-", um zu den gewlnschten Parametern zu navigieren. Wenn
der Parameter ausgewahlt wurde, wird die Anderung ebenso wie die Anderung der
Geschwindigkeit und die Min-/Max-Leistung vorgenommen.

Wahrend der Auswahl der entsprechenden Schicht kann die Z-Achse nicht bewegt werden.
Mdéchten Sie die Z-Achse wieder weiterbewegen, miissen Sie zuerst die "CL"-Taste drlicken.
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4.4 Menus

Drucken Sie die "Menu"-Taste, wenn Sie sich im Hauptmenu befinden, das folgende

Dialogfenster erscheint:
Ermagsl

Sys info

[ l
| Syscmfig |
[ Fue |
|
)

I Userpara

r Machpara

Driicken Sie die Tasten "Y+/-" zum Verschieben des Cursors. Driicken Sie die "Enter"-Taste,
um das ausgewahlte Untermenu zu 6ffnen.

4.4.1 Systeminfo

Wenn sich der Cursor auf "Sys Info" befindet, driicken Sie "Enter" zum Offnen des unten
stehenden Dialogfensters:

Systeminfo | Limitinfo
Total laser: (H:X:S) 00:00:00

Total on time: (H:X:S) |00:00:00

Total work time: (H:X:S)|00:00:00

Pre work time(H:X:S) 00:00:00

Total work times: 0

X Total trawval:(m)

0
Y Total traval:(m) 0
0

Total count: Clear

(o ) Coo |

StandardmaRig befindet sich der Cursor auf der "Read"-Taste, driicken Sie "Enter" zum
Laden aller Systeminformationen und Limitinformationen. Die Tasten “Z+/-“ kbnnen zum
Blattern in den Informationen verwendet werden, und wenn der Tab "System Info"
ausgewahlt wurde, kann die Taste “Y+/-“ zum Wechseln zwischen "System Info" und "Limit
Info" verwendet werden. Drucken Sie auf "Exit", um das Meni zu schlief3en.
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4.4.2 Systemkonfiguration

Wenn der Cursor auf “Sys config” steht, driicken Sie auf "Enter", um nachfolgendes
Dialogfenster zu 6ffnen:

~* System config

Netsetting
IP address: 000.000.000000 |
Gateway: 000000000000 |

Com

[ Ethernet |Ledtype:  HMLTF320
Write

Standardmafig steht der Cursor auf der "Read"-Taste, driicken Sie "Enter”, um die
Information zu laden. Die Tasten “Z+/-“ kdnnen zum Wechseln zwischen den Informationen
verwendet werden, wenn Informationen geé&ndert wurden, kénnen diese durch Auswéhlen
der "Write"-Taste und Driicken der "Enter"-Taste. “Lcd type” kann nicht gedndert werden. Im
Feld "Com" kann auf "Ethernet"/"USB" gedrickt werden, um das Verbindungs-
Auswahlfenster zu 6ffnen. Dieses Dialogfenster ist passwortgeschiitzt; das Passwort kann
von BRM geliefert werden.

Password: i | o ’USB 3 ’
125 [ Ok | | Exit |
( Ok | |  Exit |
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4.4.3 Funktion Untermeni

Wenn der Cursor auf "Func" steht und die "Enter"-Taste gedrtckt wird, 6ffnet sich das
folgende Dialogfenster:

' Oritgin se;ting Other ]
1 | Muti Origin enable ( Set Para |
[ Origin 1 enable

I Origin 2 enable [

1 Origin 3 enable | Autofocus |
1 Origin 4 enable

jéSet Origin: |1 v
%Next Origin: ] v
| Origin locat: Top left

1

Recover Para ]

<

Wenn der Cursor auf “Origin x Enable” steht, und die "Enter"-Taste gedriickt wird, &ndern Sie
den Status. In diesen Feldern bedeutet Rot Ein und Griin Aus.

"Multiple Origin Enable": kann aktiviert und deaktiviert werden. Wenn Sie diese Funktion
ausschalten, wird 1 Nullpunkt verwendet. Sie kénnen die "Origin"-Taste auf dem Tastenfeld
driicken und es wird nur dieser Nullpunkt verwendet. Wenn Sie diese Funktion einschalten,
wird die Multi-Origin-Logik angewendet und die "Origin"-Taste auf dem Tastenfeld wird
deaktiviert. In diesem Fall muss jeder Nullpunkt separat eingestellt werden. Das funktioniert
wie folgt:

"Origin X Enable": Wenn "Multi-Origin" aktiviert ist, kdnnen hier 4 eingestellte Nullpunkte individuell
aktiviert oder deaktiviert werden.

"Set Origin 1/2/3/4": Wenn "Multi-Origin" aktiviert ist, kann der Cursor auf "Set Origin" gesetzt werden und
"Set as Origin 1/2/3/4" gewahlt werden. Dricken Sie anschlieend auf Enter und die aktuellen Koordinaten
werden in "Origin 1/2/3/4" gespeichert.

"Next Origin": Es sind 5 Mdglichkeiten von 0 bis 4 vorhanden. "Origin 0" bedeutet, dass die "Origin"-Taste
auf der Tastatur verwendet wird. 1 bis 4 werden fir festgesetzte Nullpunkte verwendet. "Next Origin" kann
zwischen 1 und 4 gewéhlt werden und dann nimmt der Laser den betreffenden Nullpunkt fiir das folgende
Produkt (nur wenn betreffender Nullpunkt eingeschaltet ist), hier kann kein "Origin 0" gewahlt werden.

Wenn "Multi-Origin" eingeschaltet ist und "Next Origin" auf 1 steht, alle 4 Nullpunkte eingeschaltet sind und
das Programm "Take the original origin as current origin" ausgewahlt wurde, wird das Programm bei jedem
Start den folgenden Nullpunkt nehmen: 1->2->3->4->1->2.......

"Origin Location": Hier kann ausgewahlt werden, wo sich Ihr Nullpunkt in lhrem Rahmen befindet. Links

oben, rechts oben, rechts unten oder links unten.
Set Para/ Recover Para: Dieser Menlpunkt ist dem Lieferanten vorbehalten.
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4.4.4 Benutzerparameter

Wenn der Cursor auf "User Para" steht und die Entertaste gedrickt wird, 6ffnet sich
nachfolgendes Fenster.

Inci _‘ Carve | Track  Reset = Other

Idle speed: | 0.000 mom's
\Idle Acc: ‘70.000 i mm/s2
Startspeed: |0.000 mm/s
MinAce:  |0.000 mms2
MaxAce: 0000 mun/s2
Cutting mode: Normal Cuttixg v

Acc mode: ‘_Sinidz v

Standardmafig steht der Cursor auf der "Read"-Taste, driicken Sie "Enter”, um alle
Benutzerparameter einzulesen und wiederzugeben. Wenn Parameter gedndert wurden,
kdnnen sie mit der "Write"-Taste gespeichert werden. Die "Write"-Taste kann nur verwendet
werden, wenn die "Read"-Taste einmal gedriickt wurde.

445 Maschinenparameter

Wenn der Cursor auf "Machine para" steht und "Enter" gedrtickt wurde, 6ffnet sich
nachfolgendes Fenster.

i Laser Enable Axis Other

il.asez config: One tube Vi
il.aser mode: Glass tube

\ . i
Max power 1: 0 'I

il(in power 1: 0
\ i
Laser freq 1:0.000

Hax power 2: |0 KHz
%l(in power 2: 0 ‘l
Laser freaq 2:|/0. 000 KHz
‘}I.aser atten: :-0._0 I

Standardmafig steht der Cursor auf der "Read"-Taste, drlicken Sie die "Enter"-Taste, um
alle Maschinenparameter einzulesen und wiederzugeben. Wenn Parameter geandert
wurden, kénnen sie mit der "Write"-Taste gespeichert werden. Die "Write"-Taste kann nur
verwendet werden, wenn die "Read"-Taste einmal gedriickt wurde.
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45 Dateifunktionen

45.1 Speicherdateien

Im Hauptmen, wenn der Cursor auf der "File"-Taste steht. Wenn "Enter" gedrickt wurde,
offnet sich nachfolgendes Fenster

File nams Commt Freview

1 rdizz 53

Fead mem file

Tdi =k

Other

Wenn dieses Dialogfenster gezeigt wird, kénnen mit "Read mem file" die Informationen
abgefragt werden. Links wird die Liste der in der Maschine befindlichen Programme
wiedergegeben. Rechts wird ein Beispiel des aktuell ausgewahlten Programms gezeigt. “Y+/-
“-Tasten kdnnen zum Blattern in diesen Programmen verwendet werden. “Z+/-“-Tasten
konnen zum Blattern zwischen diesen Tasten verwendet werden,. Wenn eine Datei
ausgewahlt wurde, kann auf die "Enter"-Taste gedriickt werden und das Schnittprogramm
wird geladen.

Wenn die "Home"-Taste gedriickt wird, wenn eine Datei ausgewahlt wurde, wird das
folgende Dialogfenster angezeigt.

'ﬁ, asl

i[ Run

] Run: startet das ausgewahlte Programm
[ ] Track: lasst das ausgewéhlte Programm seinen Rahmen ablaufen.
[ ] Work time: gibt einen Hinweis darauf, wie lange der
Programmablauf dauern wird.
[ Clear count ] Clear count: setzt den Produktionsmengenzahler auf 0.
[ J

]

Track

fork time

Delete: I6scht das ausgewdahlte Programm.
Copy to Udisk: kopiert das Programm auf einen USB-Stick.

Delete

r Copy to Udisk

Wenn "Other" im Dialogfenster "File" gedffnet wird, erscheint
nachfolgendes Dialogfenster:

o srow ﬂ'@i Cur work time" gibt an, wie lange der Programmablauf dauern wird

"Clear all mem file count": setzt alle Z&ahler eines jeden Programms
auf 0.

"Del all mem file": I6scht alle Dateien.

"Format memory": Speicher formatieren. Dies loscht alle Dateien

[ del a1l mem file ] und leert den Speicher. Dadurch kdnnen Fehler beseitigt und die
Geschwindigkeit der Maschine verbessert werden.

[ Cur work time ]

[Clear all mem file count]

[ Format memory speedly ]

[ Format memory in grain ]

4.5.2
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4.5.2 USB-Stick

Wenn im Dialogfenster "file" die Taste "Udisk" gedrtickt wird, wird das folgende Dialogfenster
angezeigt

File name ‘
1 ED132 |

|
Read VUdisk file

| Copr to mem I

Das System zeigt nun alle auf dem - angeschlossenen - USB-Stick befindlichen Dateien an.
Der USB-Stick muss FAT32-formatiert sein und darf nicht mehr als 4 GB Speicherleistung
aufweisen. Die Programme durfen nicht in Ordnern auf dem Stick gespeichert sein. Wenn
Sie von der Maschine auf den Stick kopieren, werden die Daten auch hierhin kopiert.
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4.6 Diagnosefunktion

Wenn die "Diag"-Taste auf dem Bedienfeld gedriickt wird, wird das folgende Dialogfenster
geodffnet:

£ cheor am|

;, Limit Water prot
[umecs: Wllmec: B ower: w2z W

LmiV+: [Jrmy: [
LmiZ+: [Prmz: [
10
Switch: 55|
I Read 1

Dieses Dialogfenster zeigt an, ob wichtige Schaltungen bedient wurden. Rot bedeutet: aktiv.

4.7 Stdérungsinformation

Vorhandene Probleme kénnen dem Benutzer mit dieser Stérungsinformation mitgeteilt
werden. Die Maschine tut dies automatisch Uber nachfolgendes Fenster:

¥ Bi

| Water Error
‘ ! } ¥ork Paused

1[ ok || Exit

4.8 Notausverfahren

Mit dem Driicken des Notaustasters werden alle Maschinenbewegungen gestoppt und die
Bremsen betatigt. Ferner erscheint eine Stérungsmeldung auf dem Display des Bedienfelds.
Sobald die Bewegungen angehalten sind, werden Laserquelle und Antrieb spannungslos
gemacht und die Bremsen deblockiert. Die Achsen kdnnen dadurch manuell bewegt werden.

Bevor die Notabschaltung aufgehoben werden kann, missen deren Ursachen
beseitigt und die Maschine in einen sicheren Zustand versetzt werden.

Deblockieren Sie den Notaustaster durch eine Vierteldrehung im Uhrzeigersinn. Der Taster
springt dann wieder in seine Ausgangsposition zuriick. Anschlie3end kann die
Notabschaltung durch Dricken der Resettaste (auf der rechten Seite des Bedienfeldes)
zurtickgesetzt werden. Laserquelle und Antrieb wird wieder mit Strom versorgt. Die
Stérungsmeldung auf dem Bedienfeld kann durch Dricken auf die "Enter"-Taste geléscht
werden. Wenn die Achsen verschoben sind, wird empfohlen, den Nullpunkt erneut
anzufahren. Dazu driicken Sie auf die "Home"-Taste und navigieren nach x-y-zero (4x Y-
Taste). Anschliel3end mit der "Enter"-Taste bestatigen. Sobald der Nullpunkt erneut
angefahren wurde, kann die Produktion wieder starten.
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4.9 Technische Unterstlutzung

BMR Lasers

Technischer Leiter Eric Slotboom
Service@brmlasers.com

+31 544 350 320

Website: http://www.brmlasers.nl
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5 Software

5.1 Softwarekompatibilitat

5.1.1 Softwareunterstitzte Dateiformate

e Vektorformat : dxf, ai, plt, dst, dsb...etc.
e Bitmapformat :bmp, jpg,gif, png, mng,...etc.

5.1.2 Systemanforderungen (Environmental requirements)

e Windows XP oder héher, Windows 8 wird empfohlen.
¢ Hoher als CPU586, hoher als Pentium Ill oder Pentium IV empfohlen.
e Mehr als 1 GB Speicher empfohlen.
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5.2 Grundfunktionen der Software

5.2.1 Hauptmenu
Wenn die Software geladen wurde, wird nachfolgendes Dialogfenster angezeigt:

Menuleiste Zoomleiste Systemleiste ||Ausrichtungsleiste

FEl (=11 1] Crawl  Coniiglfl - I e g |
OwE AR e SESEHG Do o0 1Ml R %% BASEel xralBHFAMEFE
=] G =T _
] e e o B o P T e
£ = [ e frewd  Femmr Tadpd
A,
= -
e Anpassungsleiste
S
IS ik .
AN E Bedienfeld ’1
. -i_ o
: _‘- .-. II-H- } :n:a--rn?umﬂ-- E
a5 " il o ] (b, |
|k
I E
m | - - — =
i Schichtleiste T W | |
: e Tul ot || Gt |
< =] vt e RO
3 y Dl rovt et e
3 [ 1
:_- Rl et poate
L 1 | b EEEEEE o |
HUAT 'l Bl e AU 3 T AT B BEHNE T SRR e e R R W Eh T TR BN D B 11T W

5.2.1.1 _Menileiste

Die wichtigsten Funktionen dieser Software sind Uber die Menlleiste verfugbar. Die
Ausflihrung tber den Menlbefehl ist die grundlegende Nutzungsart. Meniileiste, darunter:
Dokument, Bearbeiten, Zeichnen, Einstellung, Verarbeitung, Ansicht und Hilfe.

5.2.1.2 Systemleiste
In der Systemleiste finden Sie einige der gebréauchlichsten Befehle.

5.2.1.3 Zoomleiste
In der Zoomleiste finden Sie die grundlegenden Eigenschaften der Grafikfunktionen,
einschlieB3lich des Grafikorts, der Gré3e, Skala, Anzahl der Bearbeitungen.

5.2.1.4 Anpassungsleiste

Die Anpassungsleiste befindet sich standardmafiig an der linken Seite des Arbeitsbereiches.
In der Anpassungsleiste befinden sich haufig verwendete Instrumente zur flexibleren und
einfacheren Bearbeitung.

5.2.1.5 Ausrichtungsleiste
Zur Ausrichtung der ausgewahlten Objekte.

5.2.1.6 Schichtleiste
Zur Anderung der Schicht der ausgewahlten Objekte.

5.2.1.7 BEDIENFELD
Das Bedienfeld fir Lasereinstellungen, Achsensteuerung, Schichteinstellungen usw.
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5.2.2 Spracheinstellungen und Herstellerinformationen

Aul3er der Sprachauswahl in der Installation kénnen Sie in der Software auch die im System
wiedergegebene Sprache auswahlen.
Klicken Sie auf die Mentleiste [Help] -> [[E5Language] , wéhlen Sie die gewiinschte

HelpH)
Abovt ROCAM L_q.

| 1B E fLanguage A

—_ i
D| [ I 1 FI::DID| I | I 1 Fqulﬂl 1 Engllsh
Cither

Sprache aus.
Falls Sie weitere Informationen oder Hilfe erhalten méchten, driicken Sie zum Erhalt der
Herstellerinformationen auf [Help] -> [About RDCAM]

5.2.3 Seiteneinstellung
Klicken Sie in der Mentileiste [Config] -> [Page Setting] Es erscheint das folgende
Dialogfenster:
[Page width] :die Tischbreite. Hier stellen Sie das X-MaR der Maschine ein.
[Page height] :die Tischhohe. Hier stellen Sie das Y-MaR der Maschine ein.
Unter normalen Umstéanden passt die Software das Tischmald automatisch an, wenn Sie
die Maschine mit dem PC verbinden.

Carp, Mame:
Tel:
Fax:
Addr:
Web:
Page setting
joLs Page size
Page width: | HELY mm
Wenn keine Maschine mit dem PC verbunden ist, kann hier selbst Page height: 800 s
ein Mal? gewahlt werden oder, wenn Sie die Seitengrdfl3e an das o
Bildmal anpassen mdchten, um eine deutlichere Bearbeitung zu aidepace: 50 o
erreichen. '
Kevboard
5231 IGndI adust distance: |1 mrm
Einschaltung eines Zeichenrasters und Anpassung eines Mal3es als Adjust ratio; |10
Bemal3ungs- und Ausrichtungshilfe fur Ihr Projekt. Adust angle: |1 e
5.2.3.2 _[Keyboard] coer ot ——
Die Tastatur kann zur akkuraten Verschiebung des ausgewahlten Backoround
Objekts verwendet werden. Hier kdnnen die Tastenschritte zur wororeo: |
Verschiebung des Objekts eingestellt werden. &t
. k. ancel
5.2.3.3 _[Color config] x ] [ < ]

X

Auswahl der Farben des Bearbeitungsfelds.
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5.2.4 Datei 6ffnen und speichern

Die Software verwendet .rld-Dateien, um die bearbeitete Zeichnung mit Laserinformation und
Schichtinformation usw. zu speichern.

5.2.4.1 Datei 6ffnen
(1) Klicken Sie im Menti auf [File] -> [Open] , oder klicken Sie auf das Iconi@, der folgende

EHEE O | FHEE ©) | ol

Datei auswéahlen

WHEE W) [Default rld TH @ |

HHEE@: [+ 112 SN e
 AREARITR ®

Dialog erscheint:

(2) Wahlen Sie die Datei (z. B. Default.rld) aus, klicken Sie auf [Offnen] .

5.2.4.2 Datei speichern

(1) Klicken Sie im Meni auf [File] -> [Save], oder Klicken Sie auf das Iconl, der folgende
Dialog erscheint:

REFE Q) | FHEE ©0) - = @k E-

= Defanlt. 14

Dateinamen

A

i T £l t. r1d {B1F (3] |

{RFHER (T): |RLaser Files (k. r1d) ~| By

(2) Geben Sie den gewiinschten Dateinamen ein und klicken Sie auf [Save] .
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5.2.5 Dateien importieren und exportieren

Da das Programm mit .rdl-Dateien arbeitet, missen Sie Dateien anderer Typen in das

Programm importieren.
Unterstlitzte Dateiformate fur den Import sind: dxf, ai, plt, dst, dsb...usw.

Unterstitzte Dateien fur den Export: plt

5.2.6 Datei importieren

&

Klicken Sie im Menu auf [File] -> [Import] , oder klicken Sie auf das Icon . das

folgende Dialogfenster erscheint:
Wahlen Sie Datei, Klicken Sie auf [Open] .

LT
FHFRG: [rer x| = EeF
] DOO0ER gLy [, 913 wd BT gLt
o] BT gl o] WEESLL e ) SR L
p] 700, g1, o BBIE 510
L pli nf ¥ g1t
] SO, g1t Jﬁ.ﬁiz‘ttm! R
.I.a'-'! pli _“]'E,I.Il i

HEETE nma
] Mgt gl o S Rl

vr] ADF. plo N o
] Fanech. pl 0 o HE L
vl Tn il Garen, phn o BEEED 510

Poar il ] R s, L
] Bmirere plE :1} 2 e
i Carela plt ] THOE gLt
o] COMER L bl AP gLz
wr] v gLt R
- RES-E I
rp] Jub EplL o] ATER L

| F L nd G2 gl

Rz el ] TR gLt
L::IE-'-‘ plt ol Boplt

W Eravaas

HHEW: e

THZR T [Supperead Fidesl =] il

& Wahlen Sie [Preview] , Sie sehen eine Vorschau der ausgewahlten Datei, anhand derer

Sie sehen kdnnen, ob Sie die richtige Datei ausgewahlt haben.
Vektordateien behalten ihre Schichteinstellungen bei, wenn diese in der Datei verarbeitet

sind.
Fur andere Dateien verwenden Sie die aktuell ausgewahlte Schicht.

[ [E

EEREI: [ | @ ey B
[=Raiial FT]
=]

LE045- BST
=l Ls06m. 15T
H LS. 18t
Sur, BT
= FORACNED. 5T
= STSTLTR. 5T
=l rTmstse T

F Erevies
A IE ||.1.u|.'. [~}
IHSE T [Smported Filaat =] E]

Aktuelle
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5.2.7 Datei exportieren

L&

Klicken Sie im Menu auf [File] -> [Export] oder klicken Sie auf das Icon - .Das
folgende Dialogfenster erscheint:
Geben Sie den gewtinschten Dateinamen ein und klicken Sie auf [Save] .
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5.2.8 Einstellung der Dateiparameter

File Parameter E

Irpork Sekting

PLT Precision: -
DxF Unit: gl w
[Jimport Dxf text info
[]5moath curves i i
[7] ko dlose curves 5.2.8.1 PLT-Genauigkeit
Clase error(mm): [0.1 Gemal der urspringlichen plt-Formatgenauigkeit einstellen.

[¥] Combine ines Wenn diese Einstellung in dem von Ihnen verwendeten

Combine error{mm}: |01 Programm nicht vorgenommen werden kann, verwenden Sie

die voreingestellten Werte.

Expork Sekting:

Export Precision{%); |50

5.2.8.2 Kurven glatten
Velocity Unit; |mmfs |~ Hiermit kdnnen in einer Vektordatei alle Rundungen weicherer

gezeichnet werden. Achtung, hiermit werden Anderungen an
Ihrer Zeichnung vorgenommen. Diese Funktion wird daher fur
Zeichnungen, die in einem anderen Programm vorbereitet wurden, nicht empfohlen.

[ Ok ] [ Cancel ]

5.2.8.3 Auto Kurven schlieRen
Hiermit werden automatisch alle vorhandenen offenen Linien geschlossen.

5.2.8.4 Linien verbinden
Hiermit werden automatisch Linien zu einer Linie zusammengefasst, wenn Sie innerhalb des
"Verbundfehler"-Wertes liegen.

5.2.8.5 Automatische Umsetzung der Farbskala im Grautdne
Der Laser verwendet Graustufen, um zu sehen, was er bearbeiten muss. Bei einer
Farbabbildung kann die Abbildung hier in Graustufen umgesetzt werden.

5.2.8.6 Dxf-Textnachricht importieren
Zur Erhaltung der integrierten Dokumentation der dxf-Datei wéhlen Sie diese Funktion aus.

5.2.8.7 EXPORT Genauigkeit
Exportgenauigkeit

5.2.8.8 Geschwindigkeitseinheit

Die zu verwendende Geschwindigkeitseinheit. Im Allgemeinen wird mm/s gewahlt. Diese
Einstellung wird empfohlen, wenn Sie ebenfalls Informationen via BRM erhalten méchten.
Auf Wunsch kann auch m/min. gewahlt werden.

5.2.9 Grundsatze der Grafikerstellung

5.29.1 Linie
Klicken Sie im Menu auf [Draw] -> [Line] , oder klicken Sie in der Einstellungsleiste auf

e

, ziehen Sie mit der Maus Uber den Bildschirm. Hiermit ziehen Sie eine gerade Linie.
Wenn Sie Ctrl gedrtickt halten, kdbnnen Sie horizontale oder vertikale Linien ziehen.

5.2.9.2 Polylinie
Klicken Sie im Menil auf [Draw] -> [Polyline)] , oder klicken Sie in der Einstellungsleiste auf

, ziehen Sie mit der Maus Uber den Bildschirm, um eine Polylinie zu erstellen.
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5.2.9.3 Rechteck
Klicken Sie im Menu auf [Draw] -> [Rectangle] , oder klicken Sie in der Einstellungsleiste

O

- , ziehen Sie mit der Maus Uber den Bildschirm. Hiermit zeichnen Sie einen rechten
Winkel, Ctrl gedruickt halten, um ein Viereck zu erstellen.

e X 5._2.9.4 Elllp_ se )
—1 Klicken Sie im Meni
() TrueType fornk: | T Tahoma A width: |50 %, auf [DraW] -
) 5H Font: . e . > [Ellipse] , oder klicken
Sie in der Einstellungsleiste
Text Line space: |0 mm
[¥]Enable variable text o ziehen Sie mit der

Maus Uber den Bildschirm,
um eine Ellipse zu

12HourHH:MM03:03] erstellen. Ctrl gedrtickt
12Hour[HH:MMI[09:09:21] . .
Z4Hour[HH: MM [05:09] halten, um einen Kreis zu
24Hour[HH:MMII09:09:21]

American Date[02/07/2012] erSte"en .

Chinese Date[2012502 B 07 H]
Chinese Dake Time[20125F02 B 07
Chinese Time[098T09432181]
European Date Time[07/0202012587
European Date[07.02,2012]

Wieek Year[07/02/2012 02:09:21] o 5 2 9 5 Punkt

Offset: Day [0 3 Klicken Sie im Men

auf [Draw] -

Height: 100 T [ Apply ] [ Ok ] [ Cancel ] > [Elllpse] , Oder kliCken
Sie in der Einstellungsleiste

an. klicken Sie mit der Maus auf den Bildschirm, um einen Punkt zu erstellen.

5.29.6 Text
Klicken Sie im Menu auf [Draw] -> [Text] , oder klicken Sie in der Einstellungsleiste auf

A » , danach kann ein Textfeld auf dem Bildschirm platziert werden.
Wahlen Sie die gewtinschte Schriftart aus und stellen Sie Breite, Zwischenraum und
Linienplatz ein. Klicken Sie anschlieRend auf [OK] .

Text El
(&3 TrusType Forc: | B Tabhoms - widdh: |50 L™
I ol 1
.+ SHH ol &Y FaoHy a0 mn
Text Line gpaces |0 o

| Enatie sorishie best

Die Software unterstitzt
auch variablen Text.
Aktivieren Sie dann
"Variablen Text aktivieren";
es wird ein Auswabhlfeld
gezeigt. Hier kbnnen Sie
den zu gravierenden/zu
schneidenden variablen
Text auswahlen. Dies kann
eine Zeit/ein Datum/eine
Seriennummer usw. sein.

Heght: 100 mim I_ =3 | ancel |

Diese Funktion kann beispielsweise genutzt werden, wenn jedes Produkt eine eigene
Seriennummer oder das Produktionsdatum erhalten muss.
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Text E|
(®) TrueType font: | B Tahoma v Width: |50 % E d i
, Zten E |
\ L
Ot fank: Fs.shx Char space; |0 mm
Text Ling space: |0 mm

9999

[“]Enatle variable text Enable prefix ZERO

Prefix:

[C]Enable sh array
Suffix:

Start Shi; (0000 Murnber Space
Current SM: | 0000

SN Inc: |1

(e || ®

11 8
LRI

[ oK ] [ Cancel

Height: 100 mm [ Apphy I [ oK I [ Canel I

Zur Auswahl von Seriennummer gibt es bestimmte Optionen, damit ist es mdglich,
automatisch generierte Seriennummern zu erstellen, z. B. . ABCO001DEF, ABCO002DEF,
ABCOO003DEF, usw.

52.9.6.1 [Prefix]
ein feststehender Blocktext zu Beginn der Seriennummer. Z. B. ABC.

52.9.6.2 [Suffix]
ein feststehender Blocktext am Ende der Seriennummer. Z. B. DEF.

5.2.9.6.3 [Start SN]
die erste Nummer, mit der die automatische Seriennummergenerierung beginnen muss.

5.2.9.6.4 [Current SNJ)
die aktuelle Nummer, mit der begonnen werden muss. Wenn schon ein Batch erstellt
wurde, kann dieser durch Eingabe der ndchsten Nummer fortgesetzt werden.

5.2.9.6.5 [SNInc]
um wie viel die Seriennummer erhoht werden muss.

5.2.9.6.6 [Enable Reset]

ob die Seriennummer erneut mit der Ausgangsnummer beginnen muss, wenn das Ende
erreicht wurde, z. B., ob die Seriennummer, wenn die Seriennummern von 0001 bis 9999
reichen, und 9999 erreicht wurde, wieder erneut mit 0001 beginnen muss.

5.2.9.6.7 [Enable Prefix ZERO]
ob bei den Seriennummern alle Nullen zur Nummerierung weggelassen werden mussen.

5.2.9.6.8 [Enable SN array ]

um zu einer einmalig anderen Seriennummer flr eine Sonderproduktion zu springen.
Diese Funktion kann genutzt werden, um regelmafiiig Testprodukte mit anderen
Seriennummern herzustellen (z. B. alle 100 St.).

Beispiel:

0001 0002 0003 nach diesem Batch auf 0015 0014 0013 springen

0006 0005 0004  springt direkt zur Gruppe 0007 0008 0009

0016 0017 0018 0016 0017 0018
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5.2.9.7 _Erfassung
Klicken Sie im Menu auf [Draw] -> [Capture] , oder klicken Sie in der Einstellungsleiste auf

P X
FilE:

WIA-USE s

3

Diese Funktion kann genutzt werden, um Uber eine Kamera (Webcam) eine Abbildung zu
erstellen.
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5.2.10 Objektauswahl

Wahrend des Zeichnens werden Sie verschiedene Objekte auswéahlen mussen, um das
gewilnschte Resultat erreichen zu kénnen.

Wenn ein Objekt ausgewahlt wurde, wird die Mitte durch ein X gekennzeichnet und der
aul3ere Rahmen mit 8 Punkten umgeben.

Klicken Sie im Menl auf [Draw] -> [Select] , oder klicken Sie auf die

Bearbeitungsleiste % , und andern Sie den Status auf “Auswahl’. Unter diesem Status
kénnen Sie Objekte auswahlen. Die Auswahl eines Objektes kann auf 5 Arten stattfinden.

@ Klicken Sie im Menu auf [Edit] -> [Selectall] Gchnellverkniipfung Ctrl+A) , "Select all
Objects".
€ Klicken Sie mit der Maus in das Fenster, um ein einzelnes Objekt auszuwahlen.

| | |

ag
=

(10

€ Wahlen Sie mittels einer Checkbox aus.

Driucken Sie die linke Maustaste und ziehen Sie ein Viereck um das auszuwéahlende Objekt.
Lassen Sie anschlieRend die linke Maustaste wieder los.

@ Figen Sie einer Auswahl ein zusétzliches Objekt hinzu.

Der Auswabhl hinzufligen: Dricken Sie die "Shift"-Taste und klicken Sie auf das gewunschte
Objekt oder setzen Sie ein Hakchen in die Checkbox des gewlinschten Objekts.

Ausschluss aus der Auswahl: Driicken Sie die "Shift"-Taste und klicken Sie auf das
gewtinschte Objekt oder setzen Sie ein Hakchen in die Checkbox des gewtinschten Objekts.

EEEE

B=E #H, EE IBE &l

I 5 ctTE] 100000 30,000 Yes
I et 100,000 30,000 Yes
et 100 000 30,000 Yes
hedTEl 100,000 30000 Yes
B T3] 100,000 30,000 Yes

£ >
it T

€ Wahlen Sie alle Objekte in einer Schicht.
Betatigen Sie die rechte Maustaste auf der Schicht, die Sie auswahlen mdchten.

5.2.11 Objektfarbe

Wenn Sie ein Objekt ausgewahlt haben, kénnen Sie ihm eine andere Farbe zuweisen. Diese
Farbe wird dann mit einer neuen Schicht verknlpft, sodass die Auswahl andere Schnitt-
/Gravureinstellungen nutzen kann.
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5.2.12 Objekttransformation

Transformation bedeutet, das Objekt anzupassen, ohne das reale Objekt anzupassen.
Denken Sie an das Skalieren, Drehen im Fenster.
hsELED

Transformation ist in der Registerkarte "Benutzer" maglich, hier kann das

Objekt gespiegelt, gedreht oder gerastert werden.
Die Objekteinstellungsleiste kann ebenfalls benutzt werden.

% 445,91 | ¥ (235,989 gy 100 | s J a
n Process MO |1
¥ |zea.zo8 mmo § (208,549 mmo (100 | % ﬂ EE &
Eine dritte Mdglichkeit ist die Registerkarte "Transformation" an der rechten Seite des
Fensters.

work | Output | Doc | User | Test | Transform

[+ o «| & g
Positian:

H: gy

s T
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5.2.12.1 Objekt spiegeln
Ein Objekt kann Uber die horizontale und vertikale Achse gespiegelt werden -

Klicken Sie auf "Bearbeiten" A an, wenn Sie horizontal spiegeln méchten,
=1

™1 an, wenn Sie vertikal spiegeln mdchten

Klicken Sie auf "Bearbeiten"

work || Output | Doc || User || Test | Transform

|:| Disproportionate

d_d_ 4
d o |4
O0-0-43

[ Apply o copy ]

[ Apply ]

- oder, mithilfe der Transformationstools, kopiert, gedreht oder gespiegelt werden.
5.2.12.2 Objektrotation

Klicken Sie auf "Bearbeiten" O ,ein Pop-up-Fenster erscheint, hier kann der neue Winkel
eingegeben und mit der [OK] -Taste bestéatigt werden.

Eotate E|

Rotate angleldeq) [

[ ok, l [ Cancel ]

X% 445,91 |mm 4 (235,989 mm 100 | e .
n Process MO |1
Y 299,208 |mm § 208,549 | mm (100 | % E EE &4

Oder geben Sie die Drehung unter "Objekt" ein.
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Work || Output | Doc User | Test | Transform

Rokakte:
H: |@
Center:

Hr [445.91 mm

Y. 500,791 mm

[JLock ratate center
[Irelative center

A_d_ 4
0o @ 0O
000

| Apply ko copy |

[ Apply ]
In der Registerkarte "Transformation" kann die Rotation ebenfalls angepasst werden.

5.2.12.3 ObjektgroRRe
X459 | mm |H| 235,989 | iy | (100 | =, J a .
100 | e ﬂ EE O I Process MO: |1 i

V¥ 299,208 |mm  § 205549 | mm

GrofRe und Position des Objekts kann angepasst werden. Wenn die andere Achse skaliert
werden muss, muss der Slot geschlossen sein. Wenn dies nicht der Fall ist, wird die
Objektproportion verandert.

work | output | Doz | User || Test | Transform

+ o]

Size:
H: 235,989 i

Wi 208549 | mm

[ Apply to copy ]

[ Apply ]

Dies ist auch in der Registerkarte "Transformation" mdglich.
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5.2.12.4 Achsneigung
work | Output | Doc | User | Test | Transform

+ o] & &5z
Sk

H: |0 Deg

W n} DEg

[Clilse ancher point:

[ Apply ko copy ]

[ Apply ]

Unter der Registerkarte "Transformation" wird auch die Achsneigung untersttitzt. Diese
Funktion zieht die Abbildung aus der Proportion.

5.2.12.5 Objekt im Raster kopieren

Klicken Sie unter "Bearbeiten" auf [:5 , wahlen Sie die Objekte aus, die Sie kopieren
oo
mdochten. Betatigen Sie anschlieRend die Taste "Raster"d0 dac falnende Nialnnfenster wird

angezeigt: =
Array copy @ Q

“Murn: |1 ®Space: (0.000
oo
YMum: |1 ¥Space: (0,000 oom
[ Cancel ] [ ik, |

¥ Breite eines einzelnen Objekts(mm)  Hohe einzelnen Objekts(mm)

Mit "x num"und "y num" kann die Anzahl der Kopien angepasst werden.

Nach der Auswahl der Menge und des Zwischenraums klicken Sie auf [Apply] , jetzt ist das
Resultat auf dem Bildschirm zu sehen.

5.2.12.6 Objekt an einen Nullpunkt ausrichten
Zur Ausrichtung eines Objekts an eine bestimmte Stelle kénnen verschiedene Tools

verwendet werden:
+
, das ausgewahlte Objekt zu mitteln bedeutet, es zur Mitte des Tisches zu verschieben.

R, M) e
I_ ?T _1 1_ , das ausgewahlte Objekt wird in eine Ecke des Tisches verschoben werden.
Links unten, rechts unten, links oben, rechts oben.
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5.2.13 Objekt ausrichten
Ausgewahlte Objekte an anderen Objekten ausrichten:

22N 20 HHsE0H

Die Méglichkeiten:

| (| |:|
= {} Di}' links ausrichten, rechts ausrichten, oben ausrichten, unten ausrichten.

nt L [M
- <= Wyertikal mittig ausrichten, horizontal mittig ausrichten, mittig ausrichten.

H oz

horizontal gleicher Abstand, vertikal gleicher Abstand.

= [ H

gleiche Breite, gleiche Hohe, gleiche Grol3e.

5.2.14 Objekt ansehen

Bild verschieben :Klicken Sie im Meni auf [Edit] -> [Move] ,oder klicken Sie auf
+

“ . danach mit der Maus an die gewiinschte Stelle ziehen.

%
Auszoomen: Klicken Sie im Meni auf [Edit] -> [ZoomOut] ,oder klicken Sie auf ™ . mit
jedem Klick zoomt wird die Abbildung etwas weiter ausgezoomt.
Einzoomen: Klicken Sie im Menu auf [Edit] -> [ZoomIn] ,oder klicken Sie auf ., mit jedem
Klick zoomt wird die Abbildung etwas weiter eingezoomt.
Auswahl ansehen: Klicken Sie im Menu auf [Edit] -> [View Select] ,oder klicken Sie auf

=, ziehen Sie danach mit gedriickt gehaltener, linker Maustaste einen Rahmen um die
Stelle, in die Sie einzoomen mdchten. Sobald Sie die linke Maustaste loslassen, wird in das
Bild eingezoomt.

Seite ansehen: Klicken Sie im Menu auf [Edit] -> [View Page Frame] ,oder klicken Sie auf

., das Bild nimmt die gesamte Bildschirmansicht ein.
Daten ansehen: Klicken Sie im Meni auf [Edit] -> [View Data Frame] ,oder klicken Sie auf

*, die Bildschirmansicht wird so gezoomt, dass alle Objekte angezeigt werden.
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5.3 Erweiterte Softwarefunktionen

5.3.1 Gruppieren und Gruppierung auflésen

Wenn die Bearbeitung verschiedener Objekte als 1 Gesamtobjekt erforderlich ist (wie bei
einem Textblock) kdnnen Sie diese gruppieren.
Wabhlen Sie die zu gruppierenden Objekte aus und klicken Sie dann auf: [Edit] /

[Group] ( [UmGroup]) ), oder direkt von der Werkzeugleiste aus: | % .

5.3.2 Wichtige Werkzeuge
Hier befinden sich diverse Optionen fir ein optimales und effizientes Schneiden.

5.3.2.1 Manuell sortieren und Schnittreihenfolge auswahlen
[Edit] -> [Set cutting property] In diesem Fenster kann die Reihenfolge der verschiedenen
Objekte manuell ausgewahlt werden.

Eet cutting preperty

Rl Risveroes R I
L] o (L] L]

et 2]
Ekverh
Flamant?
Eleisiritd

g

Ebrants
Elamarks
Elnark?

o R R I R

Elerrarid

I Elsverk LD
1 Flemenkl]
Eleaingh L2
EkrrariL
Elamart L4
EleigriL s
Ebrank Lt
ElarrarkL T
Elenvenk LE
Flemantl®
ElengiED
ElsverkZ]
Elrartz?

-
[ Jf‘::/kJ J’ —3__::]

EbsrantId
Ebararkrs
Elvard It
ElemantIT
ElernniZE

.
I|
&T“
"JI
1w
(D
I
f |
' '|
A EN RN ESE IS RES S
[ El

5
=
=

%
7
H
i
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5.3.2.1.1 Weg anzeigen
Wenn "Show path" aktiviert ist, wird die Bewegungsreihenfolge auf dem Bildschirm

angezeigt, um den Fahrweg des Laserkopfes zu verdeutlichen. Wéahlen Sie Diese
Taste schaltet die Schnittreihenfolge auf manuell. AnschlieRend kann die
Schnittreihenfolge manuell ausgewahlt werden. Durch Auswahl eines Elements und

Klicken auf wird dieses an die rechte Leiste verschoben. Die Maschine arbeitet die
rechte Reihe von oben nach unten ab.

Wenn Sie die gesamte Reihe riickwarts schneiden mochten, klicken Sie auf

Skt cutting propecty

] Edigl  CreeD)  CodgRl  Hndes]  Veedd eipdd
Dy e IR S EHQ D o[ 4NR0 8RR

i ==l aEl o

17 L P T T T LT L T L T
T Wb Gung (B0 [uow | WE | Fresiow
L E sww W el few  Oumc
2k B it OO KU e
S E
Ll
o - e R — - —
Al ! P ! -
';E - —— e — —
o ’ e =] ’
i —— T e T e i —_— i
ik [ —4 1 & ] =
Ak N A N | ) =i — [ ] [ &
bl i -7 - ” 3 o
B : i e e
- - — e —— [ Te———— y —_——
ik l —= —4 | |
< P Pl
EE —_—_— L?,_—'——_- "—~—_ "'_3_—'——_- Lt Frastoocess ||
E ———— e — D oot st gt
r ___IEJ 'I r ___.;:' 1 [ P
§_ [ -9: W U [-‘-;_' l-E .- T e
FATawE nioi@FAdedHlNEN BHNENENE & SENS.
Whilumai Ui wid Ui Loiar iyites of iwiliin Fogiiin U aplee wei IS0 o [ RN T
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5.3.2.1.2 Manuelles Sortieren

Wahlen Sie das Objekt, dessen Reihenfolge Sie &ndern mdchten. AnschlieRend &ndern
Sie die Nummer im Eingabefeld "Prozess-Nr.". Bestatigen Sie den neuen Wert, indem Sie
"Enter" betatigen.

% (701,941 179,559 100
mn m iy ﬂ E (¥ 0 ® Process NO: 17

Y 243,79 |mm § |63.862 |mm | 100 | %
60 [ 5200 600 ) 620 0} 640 0| 660 0| 630 0| 700 0| TUUM 740 0| 760 0| T20 0| 200 0| 220 0|
....... [ I Mk ARRRA Rt i ARRRARI AR Runs RRRRAR () RRRRE Rinh ARRRA R RERR Fuxin RRRRTR i RRRTE Ruicd RRRTH En KRTEA R RN

e

00 0
PR

Fwﬂ
T SRR Erew

X w e > (00O2 NN |A
F}U.UI

600
CEERR L

(=
=

4
G

J
a

5.3.2.2 Schnittrichtung einer Kontur dndern

Klicken Sie auf [Edit] -> [Set cut direction] , anschlieRen Doppelklick auf das Objekt,
dessen Schnittrichtung gedndert werden soll. Der rote Pfeil &ndert dann seine Richtung. Zur
Verdeutlichung dieser Bearbeitung wird empfohlen, die Taste "Show path" zu aktivieren.

5.3.2.3 Startpunkt der zu schneidenden Kontur &ndern

Klicken Sie auf [Edit] -> [Set cut point] und doppelklicken Sie auf eines der weiRen
Vierecke des Objekts, an dem die Anderung vorgenommen werden muss. Der Startpunkt
wird nun zum dem von lhnen ausgewahlten Punkt verschoben. Zur Verdeutlichung dieser
Bearbeitung wird empfohlen, die Taste "Show path" zu aktivieren.
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5.3.3 Lead-in und Lead-out einstellen

Wenn Sie Lead-in- oder Lead-out-Linien hinzufiigen moéchten, um die Verbrennung am
Startpunkt aus Ihrem Produkt zu halten, gehen Sie wie folgt vor:
Wahlen Sie das Objekt aus und klicken Sie auf [Edit] -> [Edit cut in property] , oder klicken

Sie auf © . Das folgende Dialogfenster wird angezeigt.

Cut in and out setting E|
Uk in
[+] Enable
Line type: | Line A

Lengthimm}: |2

Wwith angle -

Angle{degree): o

Zuk ok
Enable

LineType: M il

e — Um diese Funktion zu nutzen, muss sie

zunachst aktiviert werden.

Es gibt 2 Arten, Linie oder Bogen.

Bei "Linie" kdnnen Winkel und Lange gewahlt
) Male werden. Auch kann ausgewahlt werden, aus der
Mitte heraus zu beginnen.

(%) Female

Ok H Cancel ]

Lead-out

Lead-in

Mit "Arc" kénnen die gleichen Einstellungen vorgenommen werden, es kann jedoch auch
ausgewahlt werden, von innen oder auf3en zu beginnen.

Female Male
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5.3.4 Wegoptimierung

Klicken Sie im Menu auf [Edit] -> [Cut optimize] ,oder klicken Sie auf =8 das folgende

Dialogfenster wird angezeigt.

Cutting optimize handle [5_(|

[ order of layer

Inside ko outside

|Single inmer to auker w |

Block handle

Height: Cir: |Up ko bokk s

|:| Skart poink opkimize
Buto determine stark point and direction

[ Ol l [ Cancel ]

Klicken Sie im Meni auf [Edit] -> [Show Path] ,oder klicken Sie auf =), um den Fahrweg

anzuzeigen.

Laserkopf

vor der Bearbeitung nach der Bearbeitung

Der Fahrweg beginnt immer ab dem Laserkopf.
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5.3.5 Rundungen glatten

Weniger glatte Rundungen des Objekts kdnnen mit der Software geglattet werden. Das ist
fur den Schnitt und das Endergebnis von Vorteil.

Klicken Sie im Menii auf [Edit] -> [Curve Smooth] ,oder klicken Sie auf | das folgende
Dialogfenster wird angezeigt.
Curves smooth g|

Smoothness J 95% [oirect smooth

| | [ Apply HFuIIFrame][ Ok ][ Cancel ]

Ziehen Sie den "Smooth Slider" und klicken Sie auf [Apply], das Vorher und Nachher wird
im Dialogfenster angezeigt.

Die schwarzen Konturlinien zeigen die alte Vorschau. Die roten Linien zeigen das neue
Ergebnis.

Curves smooth &|

Smoothness J 95% [oirect smooth

| | [ Apply ][FuIIFrameH Ok H Cancel ]

Durch Ziehen der Maus und durch Scrollen mit dem Mausrad kann die Abbildung zur
Uberprifung des Ergebnisses betrachtet und ein- und ausgezoomt werden.
Klicken Sie auf [FullFrame], um das ganze Objekt wiederzugeben.
Wenn der gewlinschte Effekt erreicht wurde, klicken Sie auf [Apply] , die neuen
Werte werden auf das Objekt angewendet.
Mit "Direkt glatten” wahlen Sie eine andere Methode.
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Die Auswahl hangt vom tatsachlichen und gewtinschten Ergebnis ab.
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5.3.6 Geschlossene Konturen tberprifen
Klicken Sie im Menu auf [Edit] -> [Curve auto close] ,oder klicken Sie in der Systemleiste

auf 1 . Das folgende Dialogfenster wird angezeigt.

Setting close error E|

Close error (mm):

F-:-rce to close

canct

5.3.6.1 Verbundfehler:
wenn der Abstand zu den beiden offenen Punkten Kkleiner ist als der hier eingegebene Wert,
werden Sie zu 1 Kontur verbunden.

5.3.6.2 Schliel3en erzwingen:
Hiermit erzwingen Sie das SchlieRen der Kontur, auch wenn die Software damit nicht
einverstanden ist.

5.3.7 Uberlappung entfernen

Klicken Sie im Menu auf [Edit] -> [Delete overlap] ,oder klicken Sie auf Bl , das folgende
Dialogfenster wird angezeigt.

Delete overlap lines §|

[1Enable Cwerlap error

Cwverlap errormm):

| Ok, | [ Cancel

Hiermit werden Uberlappende Linien entfernt und so gekiirzt, bis sie sich gerade noch
bertihren. Verwenden Sie "enable overlap error" nur, wenn das gewiinschte Resultat nicht
erreicht wird. Stellen Sie den Wert im Feld "overlap error" nicht zu hoch ein, um fehlerhafte
Entfernungen zu vermeiden.

5.3.8 Konturen verbinden

Klicken Sie im Ment auf [Edit] -> [Combine Curve] ,oder klicken Sie auf 7=t , das folgende
Dialogfenster wird angezeigt.

Setting combine error &l

Zombine errarimm);:

Ok, ] [ Zancel ]
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Die Software schliel3t automatisch alle Konturen in den Rundungen und lasst die Rundungen
flieBend ineinander Ubergehen.
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5.3.9 Bitmap bearbeiten

Klicken Sie auf [:3 , und wahlen Sie die Bitmap aus, klicken Sie auf [Edit] -> [Bitmap
handle] , oder klicken Sie in der Systemleiste auf *".

Bitmap handle
Width: S Pixels
Height: 750 Pixels
H Resolution: 96 Pixelsfinch
V Resolution: 96 Pixelsfinch
Brightness: 0.0%
Ll
Contrast: 0.0%
6
[[J1nvert color
[ set output resolution
Resolution{pixelsfinch) |©
[CJoither
Net graphic

[ Apply to view J l Apply to source ]

[ Get outline ]

| I[Saveas ][FuIIScreen“ Ok J[ Cancel ]

Rechts oben werden Informationen Uber die Bitmap angezeigt.
Achten Sie darauf, dass diese Daten durch die Bearbeitungen in dieser Funktion geéndert
werden.

539.1 [Apply to view] :
Die Anderungen werden in die Vorschau Ubernommen. Dies ist praktisch, um zu sehen, ob
die Anderungen gewiinscht sind.

5.3.9.2 _[Apply to source] : )
Die Anderungen werden in der Bitmapdatei angepasst, und die Anderungen kénnen nicht
mehr rickgangig gemacht werden.

5.3.93 _[Saveas] :

Speichern Sie die Datei auRerhalb von Laserwork ab [Apply to view]

5.3.9.4 _[Gray scale]

Hiermit konvertieren Sie eine farbige Bitmap in eine Datei mit 256 Bit-Graustufen. Dadurch
wird die Laserleistung verbessert, da ein Laser nur in Schwarz/Weil3 und allen dazwischen
liegenden Graustufen arbeitet.
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Adjust

Invert

Sharp:

Before Processing After Processing

Es gibt 3 Varianten der Pixelkonvertierung. Diese Konvertierung ist erforderlich, um Fotos in
guter Qualitat auf ein Objekt zu lasern.

5.3.9.5 Net Graphic
Net Graphic eignet sich fur Platten mit niedriger Auflésung wie z. B. Holz, Acryl.

Als Standardeinstellung eignet sich eine Auflésung von 500-1000 und eine Netzgrol3e von
30-40. Je nach Material und Laserart muss jedoch geprtft werden, welche Einstellung das
gewtinschte Resultat erbringt.
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5.3.9.6 Dot Graphic
Dot Graphic kreiert einen guten Grauwert und ist gut fr hochauflésende Platten wie Stein,

Sahl geeignet.

Je hoher die Auﬂosung desto besser das Resultat Eine zu hohe Auflosung erzeugt jedoch
einen fehlerhaften Brennvorgang und sehr grof3e Dateien, die evtl. zu grof3 fir die Maschine
sein konnen. Eine Aufldsung von 2500-5000 ist ein guter Standard. Je nach Material und

Laserart muss jedoch gepruft werden, welche Einstellung das gewlinschte Resultat erbringt.

5.3.9.7 Schwarz und Weil3
Bei abstrakten Abbildungen kann Schwarz und Weil3 gewahlt werden. Dadurch erh&lt man
besonders klare Kanten und ubertragt das Abstrakte gut auf das Material.

éﬁlﬂ}‘{a.t% Eﬂﬁ éﬁlﬂ}'{ai% Eﬂﬁ
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5.3.9.8 Kontur erhalten:

Bitaap handle ]

F = &2
el

[ mebreven || sepbrtosorce |

| Gat aufios

Mit "Get outline” kann eine abstrakte Bitmap in Schnittlinien konvertiert werden.

5.3.10 Vorschau
Klicken Sie auf [Edit] -> [Preview] , oder klicken Sie in der Systemleiste auf &,

Fursduin

S || o i o

Die Software ermdglicht die Erstellung einer Vorschau zur Uberpriifung, ob das gewiinschte
Resultat erreicht werden kann, ohne real Material zu verbrauchen.

5.3.10.1 Anzeige der .rd-Datei:

Doppelklicken Sie mit der linken Maustaste auf die Vorschauanzeige, um ein
Dateiauswahldialogfenster zu 6ffnen. Hiermit kann jede Datei angezeigt werden, ohne sie
zuerst in Laserwork zu 6ffnen.

Open 2%
Laok jrc | (L) My Documents v s =
() Adobe Seripks LMy eBooks [C)5ource Insight
() Baidu )My 150 Files () visual Studio 2008
[=)Corel User Files My Music [ i)
[CFILTERIT4 User Settings  [(2)My Pictures
[CIRSD3tore My QQ Files
My Designs (®Iny webs
< >
Fescf e [ 3
[ Open as ead-only

Die Software bietet auch die Moglichkeit, die Vorschaufarben je Full window

nach Leistung anzupassen. Config
Klicken Sie mit der rechten Maustaste auf das Vorschaubild, es
erscheint ein Mendl.

Horizontal mirror

Yertical mirror
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Wabhlen Sie "Config.", das folgende Dialogfenster wird angezeigt.

Hier kdnnen die Farben nach eigenen Vorstellungen

angepasst werden.

5.3.11 Datencheck

Configuration

Background

Back color: Fant color: .
Diraw color{Power)

oo [ [ W oo
[ ] [

Sirnulate colorPower )

0% 100%
[T

Idle color .

Anchor
) Top left () Top right
() Battarn left () Bottom right

Wabhlen Sie alle zu Uberpriifenden Objekte aus und klicken Sie in der Befehlszeile

auf [Edit]/ [Datencheck ], oder klicken Sie in der Systemzeile El.

Check: close

[] auto close

Check self-cross

Check cross

Check overlap

[ ]Enable errar

Errorimm): |:|

Error{rmmm); I:I

Close check end

Mot find unclose curves
Self-cross check end

Mot find self-cross curves
Cross check end

Mot find cross curves
Crverlap check end

Mot find overlap lines

Check,

Hier kdnnen diverse Uberprifungen aktiviert oder deaktiviert werden. Wenn alle
durchzufiihrenden Uberprifungen aktiviert wurden, kann auf "Check" geklickt werden.
Daraufhin wird angezeigt, wie viele Fehler die Zeichnung enthélt.

5.3.12 Parallelkontur generieren

Wahlen Sie alle Objekte, die eine Parallelkontur erhalten mussen, aus und klicken Sie in der

Befehlszeile auf [Handle] / [Offset Poly] , oder klicken Sie in der

Offzet poly

Cffsekimm): mm

&In 1 ouk
Lo | |

Coelete artwark:

) Auto Infout

Cancel ]

Die rote Linie zeigt die Originalkontur an, die griine Linie

Datum:09-04-16
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die Parallelkontur.
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5.3.13 Systemeinstellungen

Es wird empfohlen, die Systemeinstellungen zu Uberprifen, bevor Sie zu schneiden
beginnen [Config] -> [System Setting)

Configls) | Handle(w)  Wiew(y:
Syster Setting
File Para Setting

Page Setting
Password Setting !

5raph Hatch
Shiowe Array
Shiow gric
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5.3.13.1 Allgemeine Einstellungen

setting

General setkings | System Info |
Axis Mirror Laser head
|:| Axis & Mirror @ O D
C 0O O
Deciz W Mirror OO0 [ ] absolute coordinate
Small circle speed limit Scanning{Reverse interval)
Diarneter{rmm’) Speedimm)'s) Speedimm)'s) Rewverse inkery. ..
< 3 || |= I
add.. | | Delete | add.. | | oel |

5.3.13.1.1.1 Spiegelachse

Diese Funktion wird von BRM eingestellt und ist nur von Bedeutung, wenn die Maschine
beim Anfahren des Nullpunktes zur falschen Seite fahrt. Hiermit drehen Sie den Nullpunkt

auf die andere Seite.

EdtiE}
Bl el S0 e S EGE0 0es ~owOHHS B %S
o

Orawil]  ConfpiZ) Harde{W) Wewl  Heldd)

¥ e i = P aE o .
T L oy o o e e L L |
53 Wt |Copet | Doc | Uner | Tt | Trarefom
i“ — Lever Mode Soeed  Foew  Dume
R |I i
i: ..\«.:_,_F-"
() I
=]
Al
t £ 5
Do
o -
i . N
E m Cuerent panki
é- | comsn | T
: T e
: [zewtarie || crwcuse |frankad
- oot wuinct graphics
Fraroghnize
- P s
- I
CEEFEEIEEETEGEETA=] | 1 [ [ [ [ 1 [ NN |

- Falooms 1o the Lums ayubam af mabling Frogess Uhe disgley sran 23T wr higher #-——

XTTA T, T 50 T
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5.3.13.1.1.2 Laserkopf

Hiermit passen Sie die Position des Laserkopfnullpunktes an.

rechts oben

mittig rechts

I
QQJ ﬂgﬂ
a0 od
links oben mittig oben
G@l Q@J
| 00 — 00
|
mittig links mittig
QQJ a0
ele a0
|
links unten mittig unten
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Im Hauptment wird der Nullpunkt mit dem griinen Punkt angezeigt.

5.3.13.1.1.3 Absolute Koordinaten
Mit absoluten Koordinaten kann ein Punkt auf der Zeichnung selbst als Nullpunkt
verwendet werden. Dieser nimmt dann den Platz eines Nullpunkts im Rahmen ein.

5.3.13.1.1.4 Hochstgeschwindigkeit kleine Kreise

Hiermit kann eine Geschwindigkeitsbegrenzung fir das Schneiden kleiner Kreise
eingestellt werden. [Hinzufugen], [Loschen], [Andern]. Ist der Kreisdurchmesser
kleiner als der eingestellte Durchmesser, wird die Geschwindigkeit auf den eingesteliten
Wert begrenzt. Dadurch wird die Rundung von Kreisen optimiert.
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5.3.13.1.1.5 Scan Backlash
Scan Backlash wird zur Optimierung der Geradlinigkeit bei der Gravur eines
bidirektionalen Scans.

5.3.13.1.1.5.1 Backlash hinzufligen

Klicken Sie auf "Add", der Bildschirm wird iemaB Abbilduni angezeigt.

Speedimm)'s)

Rewverse interval{mm) (0.3

| Ok | [ Cancel ]

Stellen Sie den Backlash und die Geschwindigkeit gemafl den Werten ein, die zum besten
Ergebnis fuhren.

5.3.13.1.1.5.2 Anpassen des Backlash
Doppelklicken Sie mit der linken Maustaste auf "Scanning” (reverse gap). Das folgende

Dialogfenster wird angezeiit.

Speed(mmys) (10

Reverse interval{mm) (0.4

| 0k, i [ Cancel ]

Stellen Sie den Backlash und die Geschwindigkeit gemaf den Werten ein, die zum besten
Ergebnis fuhren.

5.3.13.1.15.3 Backlash l6schen
Klicken Sie mit der rechten Maustaste auf den zu I6schenden Backlash und klicken Sie
auf [Delete] .
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5.3.14 Systeminfo

Setting

General settings| System Info |

Vendaor password: | [ Input

Mainboard version:

l Upgrade

Information Uber das Motherboard und den Hersteller.

Setting

meneral settings | System Info |

Tokal on kime(hourmin: s

Total processing timethour:min:s):

Previous processing timelhour:min: s:ms):

Total laser on timethour:min:s):

Total processing times:

# Tokal krawval(m):

Y Tokal kravel(m):

Mainboard version:

l Upgrade

Gesamtlaufzeit: der gesamte Zeitraum, in der das Motherboard
eingeschaltet war

Gesamte Bearbeitungszeit: der gesamte Zeitraum, in dem Programme fertiggestellt wurden
Vorangegangene Bearbeitungszeit: die Dauer des zuletzt verwendeten Programms
Gesamte Laserlaufzeit: der gesamte Zeitraum, in dem das Laserrohr
eingeschaltet war

Gesamtzeitraume: die Gesamtmenge der fertiggestellten Programme

X Gesamtstrecke: gesamte zuruickgelegte Strecke der X-Achse
Y Gesamtstrecke: gesamte zuriickgelegte Strecke der Y-Achse
Motherboard Version: die Motherboardversion
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5.3.14.1 Benutzerparameter

Work || Oukput | Doc User | Test | Tramsform

= Cut pararmeters e
Idle speed(mmfs) 300,000
Idle Accimm)s2) 2000.000
Start speed(mmm)s) 15.000
Min Accirmmyfs2) 500,000
Max Accimmfz2) 2000.000
Cutting rmode Marrnal Cutting
Acc Mode S mode

Sweep parameters
¥ Start Speedirmrs) 20,000
y Start Speedirmr)s) 15,000

¥ Accimimfs2) 2000.000
¥ Acciminmfs2) 2000.000
Line Shift Speed (mm, 150.000
Scan Mode Cormmon Mode
Facula Size(S0-99%) 93,000
= Home para
Horme speedirmmfs] 80,000
Ato home ¥ Yies
Auto home Y Yes
Auto home z Mo
Mk lmmmm 11 Bl b

Bevor Anpassungen durchgefiihrt werden kénnen, muss zuerst eingelesen werden.

5.3.14.1.1.1 Cut parameters

=] Cut pararmeters

Idle speed{mm/s) =00.000

Idle Acci{mnm/s2) 2000000
Start speed(mmiyfs) 15.000

Min Acc{mmfs2) SO0.000

Max Accirmmfs2) 2000000
Zutting mode Mormal Cutting
Acc Mode S rode

5.3.14.1.1.2 Idle speed:

Dieser Parameter gibt die Geschwindigkeit zwischen den Bewegungen des
eingeschalteten Lasers an. Wenn diese erhéht wird, kann die Maschine schneller
produzieren, unterliegt dann aber auch einem héheren Verschleil und sehr verringerter
Lebensdauer.

5.3.14.1.1.3 Idle Acc:

die Beschleunigung der Leerlaufgeschwindigkeit. Je héher die Beschleunigung, desto
schneller befindet sich der Laser auf seiner Hochstgeschwindigkeit. Zu schnelle
Beschleunigung kann jedoch die Motoren schwer belasten und Stérungen verursachen.
Ferner werden die restlichen Antriebskomponenten beschadigt, wenn dieser Wert zu hoch
ist.
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5.3.14.1.1.4 Cutting Acc:

Die Schnittbeschleunigung. Eine zu niedrige Beschleunigung verursacht eine
Verschmelzung am Schnittanfang und -ende. Durch eine zu hohe Beschleunigung werden
die Ecken nicht ordnungsgeman geschnitten.

5.3.14.1.1.5 Drehgeschwindigkeit:
Die korrekte Drehgeschwindigkeit gewahrleistet, dass die Maschine Ecken nicht zu
schnell durchféhrt.

5.3.14.1.1.6 Turning Acc:
muss gleich der Geschwindigkeit sein.

5.3.14.1.1.7 Cutting mode:
Schnelleinstellungen bewéhrter Werte fur bestimmte Schneidmethoden.

5.3.14.1.1.8 Acce. mode:
Beschleunigungsmodus flr die Motoren. Smode ist stufenweise flieRend, Tmode ist kurz
schnell.

5.3.14.1.2 Sweep Parameter
= Sweep parameters
¥ Start Speed(mmfs) 20,000
v Start Speed(mmfs) 15,000

¥ ACcimmmfs2) 000,000

v Aocimmmfs2) 2000.000

Line Shift Speed (rm. 150,000

Scan Mode Cornrnion Mode

Facula Size(S0~99%:) 92,000

5.3.14.1.2.1 X Startgeschwindigkeit, y Startgeschwindigkeit:
Die Startgeschwindigkeit, bei welcher der Laser die Beschleunigungswerte noch nicht
anwendet.

5.3.14.1.2.2 xAcc, y Acc:

Die Beschleunigung des Laserkopfes ab der Startgeschwindigkeit zur héchsten
eingestellten Geschwindigkeit. Eine zu hohe Beschleunigung belastet die Motoren bis zu
einem Punkt, an dem sie geschadigt werden kdnnen. Ein zu niedriges Niveau kann einen
langeren Auftragsdauer liefern.

5.3.14.1.2.3 Linienverschiebegeschwindigkeit des Scans:

Dies ist die Geschwindigkeit der Achse, die den Scan zur néchsten Linie fiihrt. Wenn Sie
diese zu hoch ansetzen, kann die zu gravierende Linie zu zittern beginnen. Zu niedrig
eingestellt, dauert die Auftragsausfihrung zu lange.

5.3.14.1.2.4 Scan mode:

"Scan mode" hat 2 Optionen: Normalmodus und Spezialmodus. Im Normalmodus wird der
Laserstrahl normalerweise den Strahl ansetzen, wenn es zur Gravierung erforderlich ist.
Im Spezialmodus ist der Laserstrahl mit der Faculagrol3e einzustellen.

5.3.14.1.25 Facula size:

Wenn sich der Scanmodus im Normalmodus befindet, wird diese Option aufRer Acht
gelassen. Im Spezialmodus kann hier der Startimpuls des Strahls eingestellt werden. Dies
kann eine tiefere Linie zu Beginn vermeiden, wenn hier ein niedriger Wert eingegeben
wird.
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5.3.14.1.3Home Parameter

H Home para
Home speed(mmfs) 80,000
Auto home X Yes
Auto home Y YEs
Auto home z la]
Auto hore U la]

5.3.14.1.3.1 Home Geschwindigkeit:
Die Geschwindigkeit, mit welcher er den Nullpunkt anfahrt. Eine zu hohe Geschwindigkeit

generiert einen zu weiten Schuss, wodurch ein falscher Nullpunkt entsteht. Eine zu
niedrige Geschwindigkeit verursacht eine langere Startzeit der Maschine.

5.3.14.1.32 X,Y, Z, U Auto Home:
Hier kann ein- oder ausgeschaltet werden, ob die Achsen den Nullpunkt anfahren

missen, wenn die Maschine gestartet wird.

5.3.14.1.4Parameter zum Abfahren der Skalierung
= Go Scale para

G0 scale mode Close laser

Go scale blank(mm) 0,000

5.3.14.1.4.1 Go scale mode:
Lichtpunktausschaltung.

5.3.14.1.4.2 Go scale blank:
Hier kann eingestellt werden, ob der Testrahmen gro3er als der tatsachliche Rahmen

wird. Dies zur Sicherheit, ob das Objekt wirklich darauf passt.
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5.3.14.1.5Andere Parameter
E other parameters
Array processing Bi-clir Array
Return position Absolute Crigin
Delay before feedi=)  0.000
Dealy after feedims)  0.000
Focus depthilrmm) 0.000
Backlash ¥{rnrm}) 0.0a0
Backlash ¥ {rnm) 0.0a0

5.3.14.1.5.1 Array mode:

Hier kann das Gravieren zu Einzelarray erzwungen werden; der Laser graviert dann aus
einer Richtung. Auch wenn im Programm "bidirektional" aktiviert ist, graviert er hier
trotzdem nur, wenn diese Option aktiviert ist.

5.3.14.1.5.2 Return position:
die Stelle, an welcher der Laserkopf stoppt, wenn ein Programm beendet ist.

5.3.14.1.5.3 Delay before feed:
Wenn ein Eingabegerat angeschlossen ist, kann hier eine Verzégerung nach der
Bearbeitung eingestellt werden, bevor das Eingabesystem eingeschaltet wird.

5.3.14.1.5.4 Delay after feed:
Wenn ein Eingabegerét angeschlossen ist, kann hier eine Verzégerung vor der
Bearbeitung eingestellt werden, nachdem das Eingabesystem eingeschaltet wurde.

5.3.14.1.5.5 Fokus depth:
Die Tiefe des eingestellten Autofokus.

5.3.14.1.5.6 Backlash X, Y:
Hier kann der Backlash der Achsen eingestellt werden.
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5.3.14.1.6 Dokumentenmanagement

Wark, || Qutput | Doc ser | Test || Transform

Mumber File Marmne Time(H:M:5:M5)
[ Read ] [ Process ] [ Diownload ]
[ Delete ] [ Delete all ] [ Cal time ]

5.3.14.1.6.1 Read
Durch das Klicken auf "Read" ladt die Software eine Liste der in der Maschine
eingelesenen Programme und gibt sie wieder.

5.3.14.1.6.2 Download
Hier kann ein Programm, welches sich auf der Festplatte befindet, in die Maschine
geladen werden, ohne das Programm in Laserwork zu laden.

5.3.14.1.6.3 Prozess

Hiermit wird ein Befehl gegeben, um die Maschine mit dem ausgewéahlten Programm zu
starten.

5.3.14.1.6.4 Ldschen
Hiermit kann die ausgewahlte Datei aus der Maschine geléscht werden.

5.3.14.1.6.5 Alles léschen
Hiermit werden alle in der Maschine befindlichen Programme geldscht.

5.3.14.1.6.6 Dauer
Hier wird die Produktionszeit der Programme angezeigt.
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5.3.14.1.7Kapitel 4 Verarbeitungsoutput

Laser work Prozesskontrolle
dl

[ Skark ] [ Pause/iContinue ] [ Stop T

[ SaveTolFile ] [ UFiledutpuk ] [ Dovnload ]
i . Go scale

[ ]Path optimize Niedrige

[]output select { Einstellungen Cut scale

Device

’ LISE: Auto 4——-]—/ Gerat suchen
Position: Current positic W

5.3.14.1.8 Geréat suchen

Hier kann das Gerat und die Verbindungsart gesucht und ausgewéhlt werden. Wenn
mehrere Maschinen an einem PC angeschlossen sind, kénnen diese ebenfalls ausgewahlt
werden.

(%) 3B Auka | [ search

) weh:

Default IP;

5.3.14.1.9Position
Setzen Sie die Maschine nach der Bearbeitung zurtick auf eine Position.

5.3.14.1.9.1 Current Position :
Zurlck zu der Position, auf der er vor der Produktion stand.

5.3.14.1.9.2 Original anchor :
Zurtick zum eingestellten Nullpunkt.

5.3.14.1.9.3 Machine zero :
Zurlick zur Maschine 0.

5.3.14.1.10 Go Scale, Cut Scale
Mit "Go Scale" wird der Rahmen abgefahren, um nachzusehen, ob die Maschine korrekt
lokalisiert ist.

_/

Bei "Cut scale" schneidet der Laser den Rahmen und holt so das Produkt aus der Platte.
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5.3.14.1.11 Start, Pause, Stop, SaveToUFile, UFileOutput, Download

5.3.14.1.11.1 Start:
startet die Maschine mit dem geladenen Programm.

5.3.14.1.11.2 Pause\Continue:
pausieren oder mit dem laufenden Programm fortfahren.

5.3.14.1.11.3 Stop:
Programm stoppen und abbrechen.

5.3.14.1.11.4 SaveToUFile:
fur spatere Verwendung in einem Dateiformat oder auf einem USB-Stick speichern.

5.3.14.1.11.5 UFileOutput:
eine auf einem USB-Stick gespeicherte Datei (.rd) starten, ohne sie zuvor zu 6ffnen.

5.3.14.1.11.6 Download:
das aktuell gedffnete Programm auf die Maschine downloaden.

5.3.14.1.11.7 Output select graphics
Nur die ausgewahlten Objekte werden in das Programm tbernommen.

53.14.1.12 Test

whark, || Cutput | Doc User | Test | Tramsform

Zurrent Position n=t
W=7
7=7
Lxis Move
OFfsek{mm:
Speedimm/s); (50
| - |[Mome|| X+ ||Home Power(%:: |0

[ IMove From origin
[]1f Light

5.3.14.1.12.1 Axis move:

Hier kbnnen Sie die Achsen aus der Software heraus bedienen, es kann immer nur 1
Achse in Bewegung sein. Mit "Offset" kann eine Schrittlange gesetzt werden, wenn 1x auf
die "Y+"-Taste geklickt wird, wird diese um 10 mm verschoben.

Mit "Power" und "If light" kann ein Strahl eingeschaltet werden, der bei seinen
Bewegungen ein Material ohne Programm schneidet.

Falls "Move from origin" deaktiviert ist, wird der Offset von der aktuellen Position
genommen. Falls "Move from origin" aktiviert ist, werden alle Offsetmalie von der
Maschine 0 Gbernommen.
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5.3.15 OQutputeinstellungen

Wark | Qutpub | Doc User || Test || TransForm

[ ]Enable rotate engrave

Circle pulse:

Ciameter{mm):

Speedimm)'s):

[ ]Enable feeding
Feeding Count:

Distancelmm);
[ ]Backash reapy optimize

[ ]Enable offset of Laserz

" e

5.3.15.1 Rotationssystem

5.3.15.1.1Enable rotate engrave:
Hier wird die Rotation aktiviert und der Durchmesser und Impuls eingestellt. Ferner passt
sich das Arbeitsblatt zur Optimierung der Zeichnung an.

5.3.15.1.2 Diameter:
Der Durchmesser des runden Objekts. Dieser betragt 2x den Radius, oder teilen Sie den
Umfang durch 3.1415.

5.3.15.1.3circle pulse:

Der Kreisimpuls der Maschine. Wenn Sie den Tisch verwenden, muss dieser auf 1000
eingestellt sein. Verwenden Sie jedoch die Rotation, ist eine Einstellung von 9500
erforderlich.

5.3.15.1.4 speed:

Hier kann die Rotationsgeschwindigkeit eingegeben und getestet werden. Es wird
empfohlen, diese Einstellung niedrig zu halten, um wenig Stress auf das Produkt auszuiiben.
Denken Sie an den Stiel eines Weinglases, der bei einer zu hohen geschwindigkeit
abbrechen kann.

5.3.15.2 "Feed"-Einstellung
Hier kann die Zufuhr aktiviert und der Versatz eingestellt werden. Diese Einstellung kann nur
bei einem optionalen Zufuhrsystem verwendet werden.

5.3.15.3 Optimierung der Backlashkompensation
Hiermit kann eine Backlashoptimierung aktiviert werden, durch Prifung kann ein besseres
Schnitt-/Gravierergebnis erzielt werden.

Datum:09-04-16 Seite: 88von 121



Bedienungsanleitung Laserschneidmaschine BRM 90130 Version 2

5.3.15.4 Optical 2 migration
Wenn die Maschine mit 2 Laserrohren ausgestattet ist, kann hier der Offset des 2. Lasers

eingegeben werden. Diese Funktion kann verwendet werden, wenn der 2. Laser dem 1.
malilich prazise folgen muss.
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5.3.16 Schichteinstellungen

Wiark | Outpuk | Doc lser Test TransForm

Layer Mode Speed Pawer Ckpuk

B .t 100000 20000 Yes
B Ot 300000 30000 Yes
e cut 30,000 |

-.I.-' =1

[ Up l [ D ]

Linecolumn setup

Fum spacefmm) Dislocationfmm) :l‘_’[
w1 0 0

Yol 0 ] [Bestrew... ]

Im Dialogfenster "Schicht" sehen Sie in einer Ubersicht, welche Schichten sich im Auftrag
befinden, und einige bedeutende Parameter. Wenn Sie einen Doppelklick mit der linken
Maustaste auf eine Schickt klicken, wird das Dialogfenster "Schicht" getffnet.

Layer Parameter &|
AN l Load parameters from library ]
]
_ Layer: [
L =
Is Ouktput: |58 hd
Speedirmms): [ ]Default
If Blowing: |Yes -
Processing Mode: | (Cut -
Min Power( %) Max Power(%s)
Laserl: |3EI |3D [Joefaule
Lasers: | | | |
Seal: |0.000 i
Open Delay: D ms
Close Delay: D ms
Laser through mode
v k. l [ Cancel ]
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5.3.17 Gravurparametereinstellungen

Layer:
Is Cutbput: b
Speedimmys); 400 []oefaul:
If Blowing: |Yes b

Processing Mode: | Cut -

Min Power(:) Max Power{ %)

Laserl: |30 30 [ Defaul

Laserz:

5.3.17.1 Layer:
Dieses Feld zeigt die aktuelle Schichtfarbe.

5.3.17.2 Is Output:

Hier kann eingestellt werden, ob der Laser diese Schicht verwenden muss. Steht diese
Option auf "Nein", wird die gesamte Schicht nicht geschnitten/graviert. Diese Funktion kann
dann als Zeichenhilfeschicht verwendet werden.

5.3.17.3 Speed:

Hier kann die beim Schneiden/beim Gravieren der Schicht erforderliche Geschwindigkeit
eingestellt werden. Eine niedrigere Schnittgeschwindigkeit erzeugt ein schdneres Kantenbild
und pauschal ein schéneres Produkt. Beim Gravieren mit niedriger Geschwindigkeit wird das
Detail hoher, ferner wird bei niedriger Geschwindigkeit und unveranderter Leistung tiefer
graviert.

5.3.18 |f Blowing:
Wenn die Maschine eine geschaltete Absaugung enthalt, kann diese bei der

Schichtabtragung eingeschaltet werden. Wenn die Maschine nicht tber eine geschaltete
Absaugung verflgt, besteht bei dieser Option kein Unterschied zwischen Ein und Aus.

5.3.19 Processing Methods:

Hier kann die Bearbeitungsart eingestellt werden. Schneiden oder Gravieren.
Es kénnen nur Vektor- oder Liniendateien. Bilder miissen somit zuerst angepasst werden,;
das Schneiden mit hoher Geschwindigkeit und niedriger Leistung wirkt wie eine Liniengravur.

5.3.19.1 Laser1, Laser 2:

Hier kdnnen die Laserleistungen eingegeben werden; wenn der Laser nur 1 Laserkopf hat,
wird Laser 2 keinen Effekt haben.

Die Mindest- und Hochstleistungen kénnen separat eingestellt werden, dies sind
Prozentsétze der Leistung des Laserrohrs. Eine Einstellung von 30 bei einer 100W-Rohr
erzeugt 30W Leistung. Eine Einstellung von 30 bei einem 40W-Rohr erzeugt 12W Leistung.
Abhangig von der eingestellten Prozessmethode erzielen die Mindest- und Hochstleistungen
ein anderes Einstellungsergebnis.

Zum Schneiden hangt die Mindest- und Hochstleistung von der Geschwindigkeit ab. Wenn
die Geschwindigkeit bei einer Rundung durch die Maschine gedrosselt wird, liefert der Laser
verhéltnismafig weniger Leistung. Die

Mindestleistung ist die Einstellung der Mindestleist
Startgeschwindigkeit. Meistens liegt die |

Geschwindigkeit bei 15~20. / Hochstleist
Zum Gravieren wird die Mindestleistung als

Startleistung angesehen. Der Laserstrahl arbeitet zu /

Beginn mit Mindestleistung, die sich dann bis zur _
Materialunterkante
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eingegebenen Hochstleistung steigert. Wenn keine Leistungssteigerung gewinscht ist,
missen Mindest- und Hochstleistung die gleiche Leistung haben.

Other layer parameters E'
[ ]Enable pen up and down
mm
i
Speed:(mm/s):
Paint
Dok inkerval{s) 0
Extend IO oukpuk
1ot
[ ok | [ Cancel ]

5.3.19.2 Pen up and down

Wenn die Maschine einen héhenverstellbaren Tisch oder Laserkopf besitzt, kann diese
Einstellung verwendet werden. "Pen up" bezeichnet die freie Position und "Pen down"
bezeichnet die Position des Fokus auf die Platte. Beide Positionen kénnen manuell
eingestellt werden und dann mit der Lesetaste abgerufen werden.

Verwendungsbeispiele:

1> ein Stift auf dem Laserkopf, um eine Zeichnung mit dem Stift zu erstellen.

2>um eine andere Fokushdéhe fiir die gewlinschte Schicht zu verwenden.

3>um mehr Hohe zu gewinnen, sodass der Laserkopf wahrend der Positionsverschiebung
nirgendwo anstol3en kann.

5.3.19.3 Laser Enable
Hier kbnnen bei einem zweikopfigen Laser die Laserkdpfe fir die ausgewahlte Schicht ein-
und ausgeschaltet werden.

5.3.19.4 De joint 10 output

Wenn die Maschine angesteuerte Ausgéange fir optionale Zusatzfunktionen hat, kann hier
ausgewahlt werden, ob und welcher Ausgang eingeschaltet werden, wenn die Schicht aktiv
ist.
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5.3.20 Lasergravureinstellungen

Layer Parameter

3

=3

Load parameters from library

l

Layer:

Is Cukput:
Speedimms):
I Blowing:

Processing Mode:

es hd

100 [ pefault

es hd

Scan | Advance...

Min Power(%:) Max Power{%s)

Laserl: |30

Laserz:

Ramp Length:

Cwerstriking: | Un
Scan Mode:

Inkerval{mmy: (0.1

30 ] Default

[Jindependent output:

i

-process -

#_swing b4

- [ ok

] [ Cancel ]

Layer Parameter

=3

Load parameters from library

taver: [ I
Is Qukpuk: | Yes -
Speedimmys); 100 [ pefault
IF Blowing: | Yes

X
I

Processing Mode:

-
| Advance...

Min Power (%) Max Power{ %)
Laserl: |30 30 [ oefault

Laserz:

|:| Megative Engrave |:| Optimized Scan
[ output direct [J1ndependent output:
[Iramp EFfect

Ramp Length: mm

Cwerstriking: | Un-process L4
Scan Mode: | %_swing -
Inkerval{mmy: (0.1
[ Ok ] [ Cancel ]

Links fir Vektorgravur und rechts fir Abbildungen gravieren.

5.3.20.1 Optimales Scannen:

Lassen Sie die Maschine automatisch das Interval (Scangap) berechnen, um ein optimales
Resultat zu erzielen.

5.3.20.2 Direkter

Output:

Verwenden Sie die Grauwerte, um die Laserleistung besser einzustellen. Hellgrau bedeutet
Mindestleistung und schwarz bedeutet Hochstleistung.

5.3.20.3 Abschréagung:
Hierbei wird die Gravurkante abgeschragt, um einen leichten Stereoeffekt zu erzeugen.
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5.3.20.4 Scan mode:

Hier wird der Scanmodus eingestellt. X-Achse oder Y-Achse, beide Richtungen, aber auch
aus 1 Richtung. 1 Richtung erzeugt ein schéneres, 2 Richtungen ergeben ein schnelleres
Resultat.

5.3.21 Laserschnittparameter einstellen

Layer Parameter El
L [ Load parameters Fram libraty l
I
Laver: [
Is Qutput: | S w7
Speed(mm)sy; 100 [ oefault
If Blowing: | Yes b

Processing Mode: | Cut hd Hier kann eine
g i Uberschneidung eingestellt

werden, damit am Startpunkt

Min Power(%) Max Power(%) des Schnittes das Objekt

Laserl: |30 30 [ Default nicht nicht mit dem Rahmen
verbunden bleibt.
Laserz2: | _—V
Seal; |0.000 i | »{ Strahloffnungsverzogerung
e B
Open Delay: |0 ms
——» Strahlverschlussverzégerun
Close Delay: (0 ms 9 9

[¥] Laser thm%
Wenn diese Funktion aktiviert
ist, wird die Strahléffnung
verzogert. Wenn diese Funktion
l deaktiviert ist, wird die

=~ Ck l [ Cancel

Bewegung verzdgert.

Normalerweise schneidet der Laser direkt Uber die Zeichenlinie. Sollte jedoch aufgrund der
Mal3einhaltung erforderlich sein, dass die Linie gleich dem Produktmal ist, kann hier die
Schnittbreite und die Richtung eingestellt werden. Der Laser wird dann neben der Linie
schneiden, sodass das Produkt die MaRRgabe der Linie aufweist.

Other cutting param §|

[ ]Enable sew compensation

Direction:

Sew width i

[ ok | [ Cancel
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5.3.22 Einstellung Laserpunktparameter

lLayer Parameter &|

Laver: [

Is Output; | Yes 7
Speedimmys): | 100 [ Default
If Blowing: | Yes -

Processing Mode: | Dak

Min Power(%s) Max Power( %)

* | | Advance...

Zeit, pro Punkt zu brennen. Je langer,
desto dunkler der Punkt.

Der Abstand zwischen den Punkten.

Die Lange des Punktes. GrolRe
Langen ergeben einen Strich.

Laserl: |30 30 [ Default
Laserz: |30 30

/

Dk time: |01 5
/

Dot interval: |5l mn
Lot length; |© — "
[ Certer dN

Punkte nur in der Mitte.

ok ] [ Cancel ]

5.3.22.1 Zeilen-/Spalten-Setup

Hier kann das Raster eingestellt werden. Abhéngig von eigenen Praferenzen kann
ausgewahlt werden, ob das Rahmenmal oder das Herz der Objekte als Rastermald

eingestellt werden kann.

gl [4F]

Rahmenmaf

Herzmafl.

[Streuen] :Diese Funktion kann dazu verwendet werden, ein nichtlineares Raster zu
erzeugen; unter Umstanden passen so mehr Produkte auf eine Platte. Wenn Sie auf

"Streuen" klicken, erscheint ein Pop-up-Fenster.
Bestrewaing breadth &|

¥ breadehlmm):

Y braddthlmm); | S00

[ Ok l [ Cancel ]

Hier kann das Plattenmalf3 eingegeben werden; die Software setzt automatisch so viele

Produkte auf die Platte, wie hochstens darauf passen.
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6 Justieren und Strahl ausrichten

Zur Erzielung eines guten Schnittresultats ist eine korrekte Ausrichtung ausschlaggebend.
Eine fehlerhafte Ausrichtung kann die gelieferte Qualitat verschlechtern.

Die Ausrichtung des Laserstrahls besteht aus mehreren Schritten, die nacheinander und in
der richtigen Reihenfolge ausgefiihrt werden mussen.

Zur Ausrichtung muss die Maschine eingeschaltet sein.

Thefirst mirror

Laser beam

v

4

The third mirror l

/

The second mirror

Z-Verstellung fur den Spiegel
Y-Verstellung fiir den Spiegel
X-Verstellung fir den Spiegel
Strahlausrichtung bzgl. Hohe
Strahlausrichtung bzw. Horizontale
Korrekturschraube zur Strahlausrichtung
Federn zur Spiegelstabilisierung

NoghkwhpE
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Wenn der Strahl hinsichtlich der Strahléffnung zu hoch oder zu niedrig eingestellt ist, kann
mittels Stellschraube 4 der Strahl noch oben oder unten nachjustiert werden.

Wenn sich der Strahl hinsichtlich der Strahléffnung zu weit nach links oder rechts befindet,
kann mittels Stellschraube 5 der Strahl noch oben oder unten nachjustiert werden.

Die Maschine muss nach der ersten Installation und regelmafig ausgerichtet und
nachjustiert werden.

6.1 1. Spiegel

Zur Justierung des 1. Spiegels 6ffnen Sie die Klappe des
Laserresonatorraums auf der Riickseite der Maschine. Dort
sehen Sie den Stander fiir den 1. Spiegel mit dem montierten
Spiegel und dem Laserrohr.

Auf dem Spiegelstander befindet sich ein Halter, auf den Sie 2
Lagen Klebeband kleben missen. Driicken Sie es fest an,
sodass die Rundung durch das Klebeband zu sehen ist.
SchlieRen Sie nun die Klappe des Laserresonatorraums.
Durch die Lasersicherung wird der Laserstrahl nicht aktiviert,
wenn 1 oder mehrere Klappen gedffnet sind.

Wenn die Klappe geschlossen ist, driicken Sie sehr kurz auf

die "Puls"-Taste. &= Danach kénnen Sie die Klappe
wieder 6ffnen und Sie sehen, dass sich ein brauner bis
schwarzer Brandfleck auf dem Klebeband befindet.
Uberprifen Sie, ob sich dieser Fleck in der Kreismitte befindet.
Wenn dies nicht der Fall sein sollte, kénnen Sie das Laserrohr
mithilfe der Stander versetzen. Versetzen Sie das Rohr nur in
kleinen Schritten und pulsen Sie nach jeder Versetzung neu,
um zu Uberprifen, ob sich der Strahl nun korrekt in der
Kreismitte befindet.

Achten Sie jedoch darauf, dass das Rohr so gerade wie mdglich Richtung Spiegel steht,
wenn Sie den linken Stander versetzen, muss auch der rechte Stander versetzt werden.
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Wenn der 1. Spiegel korrekt steht, kdnnen Sie den 2. Spiegel anpassen.
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6.2 2. Spiegel

Der Spiegel befindet sich auf dem Portal an der Seite des
Arbeitsraums. Kleben Sie 2 Stucke Klebeband auf den Halter und
schlie3en Sie alle Klappen. Setzen Sie den Laser oben hinein,

indem Sie die Taste eingedrickt halten, bis das Portal ganz
hinten steht (in Richtung Laserrohr). Anschlie3end driicken Sie

, um einen Punkt auf dem Klebeband zu erzeugen. Kleben
Sie danach auf diesem Klebeband noch ein Stiick Klebeband rund

fahren Sie anschlielBend das Portal mit der v Taste nach vorne.
Pulsen Sie nun noch einmal und Uberpriifen Sie, ob beide Punkte
aufeinanderliegen. Je besser sie aufeinanderliegen, desto besser
wird lhr Schnittresultat. Wenn sie nicht richtig aufeinanderliegen,
mussen Sie den 1. Spiegel mit den 3 Stellschrauben nachjustieren.

Wenn Sie den 2. Spiegeln korrekt ausgerichtet haben, kommt der 3.
Spiegel an die Reihe. Dieser befindet sich im Laserkopf.

Y+Position des 2. Spiegels einstellen Y- Position des 3. Spiegels

T
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6.3 3.Spiegel s s

Kleben Sie auf die linke Seite oben auf der Laser6ffnung des
Laserkopfes 2 Stiicke Klebeband. Setzen Sie den Laserkopf links

oben mit den Tasten A und <1 und dricken Sie danach auf

Kleben Sie noch ein Stlck Klebeband und versetzen Sie den

Laserkopf mit der Taste D nach rechts oben. Pulsen Sie nun
noch einmal. Wenn beide Punkte aufeinanderliegen, liegt der 2.
Spiegel korrekt, wenn dies nicht der Fall ist, muss der 2. Spiegel mit
den Stellschrauben nachjustiert werden. Uberpriifen Sie hierbei alle
4 Ecken der Maschine.

Wenn alle Einstellungen korrekt vorgenommen wurden, kann mit
der Linsenjustierung begonnen werden.

X+Y- Position

X-Y+ Position X+Y+ Position
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6.4 Linsenjustierung

Die Linsenjustierung ist zur Gewahrleistung dessen erforderlich, dass der Strahl in der Mitte
geradlinig durch die Linse fallt, sodass der Schnitt auch an allen 4 Seiten gerade ist.

Der Kopf muss zur Tischmitte gefahren werden. Hierbei kommt es
nicht auf Millimeter an, pauschal mittig mittels der Richtungstasten
ist ausreichend. Sie brennen mit Linse und Duse ein Loch auf
Fokusniveau in 2 Klebeb&ander. Anschlieend entfernen Sie den
Linsenhalter und setzen Sie die Z-Achse oben hinein. Zeichnen Sie
nun ein Kreuz auf Ihr Klebeband und legen Sie ein neues Stlick
Klebeband dartber. Pulsen Sie nun, um einen Punkt auf dem Band
zu erzeugen. AnschlieBend kleben Sie ein Stiick Klebeband und
setzen die Z-Achse unten hinein. Nun brennen Sie den 2. Punkt.
Dieser Punkt muss Uber dem 1. Punkt liegen. Wenn dies nicht der
Fall ist, muss der 3. Spiegel ausgerichtet werden. Wenn beide
Punkte gerade Ubereinanderliegen, muss der Strahl in die Mitte des
Kreuzes gelegt werden. Dies wird durch Herein- oder Herausdrehen
der Stellschrauben des Spiegels erreicht. Der 2. Spiegel ist dann fiir
die X-Achse und der 3. Spiegel ist fir die Y-Achse zustandig. Nach
diesen Arbeiten muss wieder von Abschnitt 6.2 begonnen werden,
um zu gewahrleisten, dass hier keine Abweichung aufgetreten ist.

6.5 Fokus suchen

Wenn alle Einstellungen korrekt durchgefiihrt worden sind, muss
der Fokus gefunden werden. Jede Linse und Maschine hat einen
anderen Fokus und auch durch den Verschleil3 einer Linse kann
sich dieser Punkt verschieben. Mit dem mitgeliefertem
Fokussierwerkzeug stellen Sie den Kopf auf die hdchste
Fokuseinstellung ein. Brennen Sie ein Loch auf ein Stiick
Klebeband. Mit der ndchsten Fokushohe verfahren Sie ebenso;
brennen Sie neben den soeben geschossenen Punkt. Verfahren
Sie so mit allen Hohen.
Uberprifen Sie anschlieRend,
welche HOhe den kleinsten
Punkt erzeugt. Auf dem Beispiel
in der Abbildung ist das 7 mm.
Dies ist dann der Fokus fur die
aktuelle Aufstellung.
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7 Problemlésungen

Doppelte Schnittlinien

Diese werden durch nicht korrekte Justierung der Strahllinie verursacht. Hierdurch prallt der
Strahl in der Dise ab und die Reflexion wird auf dem Produkt sichtbar. Weitere
Informationen Uber die Fokusjustierung siehe Kapitel 6.

Ovaler Fokus

Dieser wird durch nicht korrekte Justierung der Strahllinie verursacht. Hierdurch prallt der
Strahl in der Dise ab und die Reflexion wird auf dem Produkt sichtbar. Weitere
Informationen Uber die Fokusjustierung siehe Kapitel 6.

Unspezifischer Geruch

Dieser wird durch eine inaddquate Absaugung verursacht. Sollten Sie Uber eine Bofa
Absaug- und Filteranlage verfiigen, muss deren Laufgeschwindigkeit erhdoht werden. Falls
Sie die originale Absaugung benutzen, kann es sein, dass der Schlauch abgeklemmt ist. Bei
beiden Absauganlagen kann das Problem auch darin liegen, dass zu viele Laserriickstande
auf der Absaug6ffnung liegen.

Leistungsverlust

Dieser wird durch nicht korrekte Justierung der Strahllinie verursacht. Hierdurch prallt der
Strahl in der Diise ab und die Reflexion wird auf dem Produkt sichtbar. Weitere
Informationen Uber die Fokusjustierung siehe Kapitel 6.

Sollte die Einstellung jedoch korrekt sein, kann die Ursache auch eine zu niedrig eingestellte
Leistung oder ein Zeichen, dass das Laserrohr schlechter wird, sein.

Kihler piept
Diese Gerausche kommen vor, wenn die Temperatur zu hoch ist (héher als 35°C) oder durch

einen schlechten Durchfluss. Wenn die Temperatur zu hoch ist, muss die Produktion
unterbrochen werden, bis die Temperatur wieder gesunken ist. Sollte dies nicht der Fall sein,
kann ein abgeklemmter Schlauch oder ein Schmutzpfropfen in der Leitung die Ursache sein.
Dies muss Uberpruft werden, bevor die Produktion fortgesetzt wird.

Breite Schnittlinien
Die Ursache liegt in einem inadaquaten Fokus. Weitere Informationen siehe Kapitel 6.5.

Datei kann nicht importiert werden.

Hier kann die Ursache darin liegen, dass versucht wird, eine Datei einer neuen Generation
zu importieren. Laserwork kann lediglich Dateien &lterer Generationen verarbeiten.
Versuchen Sie, die Datei in einem Dateiformat aus der Zeit 2002/2004/2006/2008
abzuspeichern.

Maschine I&sst sich nicht einschalten

Das ist moglich, wenn die Notabschaltung ausgelést wurde, der Netzstecker nicht
eingesteckt wurde oder der Sicherungsautomat ausgeldst hat. Wenn Sie das rechte das
rechte Seitenpaneel leicht 6ffnen, sehen Sie an der Vorderseite der Maschine den
Sicherungsautomaten.

Aus dem Kopf kommt kein Luftstrom

Die Leitung in oder auRerhalb der Maschine ist gequetscht. Sollte dies nicht der Fall sein, ist
es auch maglich, dass das Drosselventil, welches sich am Laserkopf befindet, geschlossen
ist.

Abbildung falsch herum graviert
Mdglicherweise wurde ein Viereck in der Zeichnung unter der gleichen Schicht gesehen.
Entfernen Sie diesen Rahmen, um das Problem zu l6sen.
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Motor knarrt

Dieses Gerausch kann durch eine zu hoch eingestellte Geschwindigkeit auftreten. Wenn die
Maschine viele Konturen schneiden und somit die Geschwindigkeit haufig drosseln muss,
empfehlen wir eine Hochstgeschwindigkeit von 40 mm/s.

Antrieb knarrt auch bei niedrigen Geschwindigkeiten

Dieses Gerausch kann auftreten, wenn haufig mit hohen Geschwindigkeiten geschnitten
wurde. Dadurch verschlei3en die Lager mehr, die nun wahrscheinlich ausgetauscht werden
mussen.

Maschine l&sst sich nicht zuriicksetzen, auch wenn alle Klappen geschlossen sind

Das ist moglich, wenn die Notabschaltung ausgeltst wurde. Fihren Sie die Schritte gemafi
Kapitel 4.8 durch. Sollte sich dadurch das Problem nicht beheben lassen, kann eine Klappe
verbogen sein. Uberpriifen Sie nochmals, ob alle Kontaktschalter korrekt funktionieren. Das
sehen Sie an den Tirschaltern selbst, da diese mit einer LED-Leuchte ausgestattet sind.

Briicke fahrt schief
Das ist mdglich, wenn die Bandspannung an einer Seite zu niedrig ist. Spannen Sie das
Band gemal? Beschreibung in Kapitel 9.5.

Linien sind auf der Zeichnung nicht sichtbar, werden jedoch geschnitten

Dieses Problem tritt auf, wenn eine Zeichnung aus einem anderen Programm importiert
wurde, viele Zeichenprogramme legen programmspezifische Konstruktionslinien an. Diese
werden von Laserwork als Schnittlinien angesehen. Andern Sie die Zeichnung und
importieren Sie sie erneut, um das Problem zu l6sen.

Maschine bewegt sich bei der Bedienung nicht

Das ist mdglich, wenn eine Klappe geotffnet ist oder die Notabschaltung ausgeldst wurde.
Schliel3en Sie alle Klappen und setzen Sie die Notabschaltung zuriick, um weiter mit der
Maschine arbeiten zu kdénnen.

Maschine kann keine Verbindung zum PC aufbauen
Das ist mdglich, wenn der USB-Stick in einen anderen Port gesteckt wurde. Dieses Problem
ist durch erneutes Installieren der Software zu beheben.

Produkt entziindet sich schnell
Das ist mdglich, wenn die Geschwindigkeit zu niedrig eingestellt ist oder zu wenig Luft
verwendet wird.

Absaugung funktioniert schlecht

Sollten Sie Uber eine Bofa Absaug- und Filteranlage verfligen, muss deren
Laufgeschwindigkeit erhdht werden. Falls Sie die originale Absaugung benutzen, kann es
sein, dass der Schlauch abgeklemmt ist. Bei beiden Absauganlagen kann das Problem auch
darin liegen, dass zu viele Laserriickstdnde auf der Absaugoffnung liegen. Bei einer Bofa
Absaug- und Filteranlage kann auch der Filter verschmutzt sein.

Laserkopf fahrt nicht flieRend

Die Ursache liegt in einer zu hoch eingestellten Geschwindigkeit. Drosseln Sie die
Geschwindigkeit, um das Problem zu beheben. Sollte das nicht gliicken, fihren Sie die
Schritte gemal Kapitel 9.4 durch, um die Fihrungen zu reinigen und zu 6élen.

Vibrationen in der Gravurlinie
Das ist mdglich, wenn mit zu hoher Geschwindigkeit graviert wird. Ggf. muss die
Geschwindigkeit gedrosselt werden.

Maschine erzeugt bei Achsbewegungen viel Larm
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Die Ursache liegt in einer zu hoch eingestellten Geschwindigkeit. Drosseln Sie die
Geschwindigkeit, um das Problem zu beheben. Sollte das nicht gelingen, fiihren Sie die
Schritte geman Kapitel 9.4 durch, um die Fuhrungen zu reinigen und zu dlen.

X-Y-Achse funktioniert hin und wieder nicht
Die Ursache kann ein Bruch im Signalkabel zum Motor sein. Wenden Sie sich an BRM und
vereinbaren Sie eine Reparatur.

Y-Achse ist spannungslos
Uberprifen Sie, ob der Schalter auf dem rechten Seitenpaneel zur Stromversorgung der Y-
Achse ausgeschaltet ist. Ferner kann es sein, dass der Schalter Y-U auf der U-Achse steht.

Laserstrahl funktioniert gar nicht mehr
Die Ursache kann ein defektes Laserrohr sein, oder der Kihler ist ausgeschaltet.

Pulspunkt bei der Justierung nicht sichtbar
Mdgliche Ursachen sind: eine getffnete Klappe, eine ausgeschaltete Kuhlung, eine zu
niedrig eingestellte Hochstleistung auf dem Bedienfeld.

Maschine referiert nicht korrekt
Mdgliche Ursachen sind eine getffnete Klappe oder eine ausgeldste Notabschaltung.

Gravurlinien verschoben
Eine mogliche Ursache ist, dass das Band der X-Achse sich gelockert hat- Fihren Sie die
Schritte gemaf Kapitel 9.5 durch, um das Problem zu beheben.

Maschine graviert nicht, Stérungsmeldung: zu kleines Feld

Beim Gravieren hat die Maschine einen Auslauf. Dieser Auslauf liegt dann auf3erhalb des
Maschinenbereichs. Verschieben Sie den Auftrag weiter von der Kante weg oder drosseln
Sie die Geschwindigkeit, um dieses Problem zu beheben.

Bofa Absaug- und Filteranlage
- Rote Leuchte blinkt
Das Bedeutet, dass die Filter voll sind. Sollten Sie schon Filter gekauft haben,
mussen diese nun eingesetzt werden, ansonsten kénnen Filter auch bei BRM Lasers
bestellt werden. Die Maschine darf bis zum Austausch der Filter nicht verwendet
werden. Bitte beachten Sie, dass BRM nicht fir Personenschaden aufgrund des
Schneidens mit vollen Filtern haftet.

- QOrangefarbene Leuchte blinkt
Das bedeutet, dass die Filter zu 75 % voll sind. Es wird empfohlen, neue Filter zu
bestellen. Diese kdnnen bei BRM Lasers bestellt werden.

- Der Motor lauft auf hoher Drehzahl, aber ohne Saugkraft.
Mdgliche Ursachen sind ein abgeklemmter Absaugschlauch, volle Filter oder ein
verstopfter Absaugschlauch.

- Schlechte Absaugung trotz hoher Drehzahl
Mdogliche Ursachen sind ein abgeklemmter Absaugschlauch, volle Filter oder ein
verstopfter Absaugschlauch.
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8 Transport und Lagerung

8.1 Abklemmen/Bereitstellung zum Transport

Zum Abklemmen der Maschine zur Umstellung, zum Transport oder Verkauf der Maschine
missen einige Schritte ausgefuhrt werden.

Das Laserrohr wird mit Kihlwasser gekihlt, das aus demineralisiertem Wasser und
Antifrostschutzmittel besteht. Dieses Kihlwasser befindet sich permanent in der Maschine.
Vor dem Transport muss das Kihlwasser aus dem Laserrohr entfernt werden, um einen
Bruch des Laserrohrs durch das Gewicht des Kiihlwassers zu vermeiden.

Achtung! Das KuhImittel ist gesundheitsschadlich.

Zur Entfernung des Kiihlwassers missen die 2 Schlauche, die zum Kihler fiihren,
abgenommen werden. Der Zufuhrschlauch zur Maschine muss in einen Auffangbehélter
gelegt werden. Der Abfuhrschlauch muss an den eingeschalteten Kompressor
angeschlossen werden.

Der Kompressor pumpt das Kiihimittel vollstandig ab. Uberpriifen Sie dies, indem Sie die
Laserklappe 6ffnen. Der Vorgang ist abgeschlossen, wenn das gesamte Kihimittel aus dem
Rohr entfernt wurde.

Koppeln Sie den Kompressor von der Maschine ab. Wenn das Laserrohr kein Kiihlwasser
mehr enthélt, konnen der Netzstecker, das Kihleralarmkabel, die Zu- und Abfuihrschlauche
von der Maschine abgekoppelt werden. Das Kihimittel im Auffangbehalter kann als
chemischer Kleinabfall entsorgt werden.

Drehen Sie alle Fi3e hoch und I6sen Sie die Bremsen von den Radern. Die Maschine ist
nun transportbereit.

8.2 Lagerung der Maschine

AusschlielZlich in einem klimatisierten Labor/Lager mit einer Temperatur zwischen 20 und
23°C und einer relativen Luftfeuchtigkeit von ca. 50 %.

Stellen Sie die Maschine nicht in der Néhe einer Heizung oder anderen Warmequelle auf.
Stellen Sie die Maschine nicht in Wassernéhe auf.
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9 Reparatur/Wartung (mechanisch)

Waéhrend Reparatur- und/oder Wartungsarbeiten muss der Hauptschalter
(Netzschalter) ausgeschaltet sein.

Durch das Offnen des Gehauses konnen gefahrliche Situationen entstehen und eine
mogliche Garantie verliert ihre Gultigkeit.

Sowohl der Hersteller als auch der CE-Zertifikatsinhaber haften nicht flr Folgen, die
durch die Nichtbeachtung dieser Warnung entstehen.

Sollten unvorhergesehene Defekte an der Maschine entstehen, muss Kontakt mit BRM
Lasers aufgenommen werden.

Sollten nach Ricksprache mit dem Hersteller Komponenten ersetzt werden mussen,
muss dies durch einen ausgebildeten Techniker erfolgen.

Tagliche Wartung/Pflege und Kontrolle durch den Maschinenbediener vor und
wéhrend des Betriebs der Maschine:

¢ Reinigen Sie die Maschine und Arbeitsumgebung vor und nach der Nutzung.

e Uberpriifen Sie die Schmierung der Ubersetzung auf die Hauptachse (also des
Antriebs).

Tagliche Wartung/Pflege (durch den Maschinenbenutzer)

-Uberpriifung der Spiegel und, falls erforderlich, Reinigung/Austausch (siehe Paragraf 9.1)
-Uberprufung der Linse auf Defekte und, falls erforderlich, Reinigung/Austausch (siehe
Paragraf 9.1)

Wochentliche Wartung/Pflege (durch den Maschinenbenutzer)
-Uberpriifung der Duse auf Verunreinigungen/ausreichenden Luftdurchlass
-Leerung und Reinigung der Abfalllade

Monatliche Wartung (durch angewiesenes Personal (technischer Dienst oder
Maschinenbenutzer, wenn dazu ausgebildet)

-Ausrichtung des Laserstrahls (siehe auch Kapitel 6)

-Reinigung der Schmierung an den Fuhrungen (siehe Abschnitt 9.4)

-Uberprufung, ob die Antriebsriemen korrekt gespannt sind (siehe Abschnitt 9.5)
-Uberpriifung, ob der Tisch flach ist (siehe Abschnitt 9.6)
-Kuhlmittelfallstandskontrolle (siehe Abschnitt 9.7)

-Uberpriifung der Kiihimittelfarbe (siehe Abschnitt 9.8)

9.1 Reinigung und Inspektion der Linse und der Spiegel

Tagliche Uberpriifung und Reinigung aller Oberflachen, auf welche der Laserstrahl fallt.
Wenn sich Verschmutzungen auf den Spiegeln festsetzen, greift das den Laserstrahl an und
die verfluigbare Leistung kann abfallen. Mit verschlissenen Spiegeln und verschlissener Linse
kann auch eine ansonsten einwandfreie Maschine mit gutem Laserrohr nicht in der Lage
sein, das einfachste Material zu schneiden,

Die Maschinen weisen 3 Spiegel (4 bei Metalllasern) auf, um den Strahl zum Laserkopf zu
senden. Im Laserkopf befindet sich eine Linse, um den geraden Strahl zu einem Punkt zu
blndeln, der das Material wegbrennen kann.
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Der 1. Spiegel befindet sich am Strahlrohr, das den Strahl zum 2. Spiegel sendet. dieser
befindet sich auf dem Portal (der gro3e Balken, an dem der Laserkopf hangt) und reflektiert
den Laserstrahl zum 3. Spiegel, der wiederum im Laserkopf montiert ist. Dieser 3. Spiegel
leitet den Strahl in Richtung Linse, die den urspriinglichen, geraden Strahl zu einem Punkt
bundelt, der auf Ihrem Produkt endet. All diese Oberflachen miissen sauber sein, damit der
Laser eine gute Leistung erbringen kann. Beachten Sie, dass es empfindliche Oberflachen
sind, die mit 70-prozentigem Alkohol und einem Wattestab gereinigt werden miissen. Andere
Inhaltsstoffe kdnnen Schéaden verursachen. Kratzer sind fatal fur den Laser; in dem Fall
mussen Spiegel oder Linse ersetzt werden. Zum Kauf neuer Linsen oder Spiegel wenden Sie
sich bitte an BRM. Achten Sie darauf, Ersatzspiegel/-linsen auf die gleiche Art und Weise
einsetzen, auf die Sie die alten herausgeholt haben.

K )

9.2 Uberpriifung der Diise

Die Duse ist der unterste Punkt des Laserkopfes. Er befindet sich
hinter der Linse, von wo aus der Strahl zu einem Punkt geblindelt
wird. Die DUse ist die Stelle, an der die Luft (oder O, fir Metall) in
den Laserkopf gefiihrt wird. In der Kopfspitze befindet sich eine
Offnung, durch die der Strahl und die Luft/ das O, austritt. Die
Offnung muss sauber sein, damit die Luft/das O gut
hindurchstromen kann und der Strahl nicht behindert wird. Auch die
Offnung am Luftschlauch muss sehr sauber bleiben.

9.3 Leerung und Reinigung der Abfalllade

' — \ Die Abfalllade muss sauber gehalten werden.
Schneidstoffe sind entziindlich und ein Zuviel an
Schneidstoffen kann sich durch die Hitze des
Laserstrahls entztinden. Der Eintritt an der
Absaugung muss gut sauber gehalten werden, um
eine gute Abnahme der Lasergase zu gewahrleisten.
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9.4 Reinigung der Schmierung an den Fihrungen

Portal und Laserkopf werden tber Fihrungen bewegt. Je reibungsloser sie laufen, desto
besser ist es fur die Motoren, die Filhrungen und das Produkt. Wenn sich viel Schmutz
darauf befindet, lauft die Maschine mit einem kratzenden Gerausch statt mit einem Summen.
Dieses kratzende Gerausch bedeutet, dass sich auf den Fihrungen befindlicher Schmutz
hineinfrisst und die Maschine beschadigt, Wenn dieses Problem nicht behoben wird, tritt zu
gegebener Zeit ein so groRRer Schaden auf, dass ein Austausch der Fiihrung zur
Gewahrleistung der garantierten Produktqualitat die Folge ist.
Ein alleiniges Einfetten ist nicht ausreichend. Wischen Sie zuerst mit einem Papiertuch tber
alle Fihrungen, um sie vollstandig zu entfetten, aber auch vollstandig zu reinigen. Fetten Sie
erst dann erneut. Spriihen Sie auch die Achsen der Zahnréader ein, um ein schwerfalliges
Drehen zu vermeiden.
— -
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9.5 Uberpriifung, ob die Antriebsriemen korrekt gespannt sind

Laserkopf und Portal werden mittels Antriebsriemen bewegt. Diese dirfen nicht zu schlaff
eingestellt sein, da dadurch Abweichungen erzeugt werden. Mit der Zeit dehnen sie sich und
werden auch dadurch schlaffer. Mittels der Stellschrauben kann die Spannung wieder
hergestellt werden. Schieben Sie zuerst den Laserkopf in die Maschinenmitte. Schauen Sie
dann entlang des Riemens und der Fihrung dariiber. Wenn der Riemen nicht parallel zur
Fuhrung liegt, ist er zu schlaff. Driicken Sie danach vorsichtig mit einem Finger auf den
Riemen und driicken Sie ihn gegen die Fuhrung.

Bei der X-Achse kann man nicht sehen, ob der Riemen zu schlaff ist. Ziehen Sie ihn daher
vorsichtig zu sich hin, bis sie einen etwas erhohten Widerstand fihlen. Dann messen Sie den
Abstand zur Fuhrung. Er darf héchstens 30 mm betragen. Ist der Abstand viel groRer, ist der
Riemen zu schlaff. Dies gilt auch fur die Y-Achse; driicken Sie diesen Riemen hiernach mit
dem Finger gegen die Fihrung.
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9.6 Uberpriifung, ob der Tisch flach ist

Der Tisch muss flach sein, damit die Schnittqualitat tber den gesamten Tisch optimal ist.
Wenn der Tisch an einer bestimmten Stelle niedriger oder héher liegt, ist die Schnittqualitat
schlechter, da dort der Fokus nicht auf dem eingestellten Niveau liegt.

Die Tischtrager sind mit diversen hohenverstellbaren Schrauben befestigt. Durch Messung
vom Portal aus kann 1 Maf3 bei jeder Schraube eingehalten werden, was zur Folge hat, dass
der Tisch gerade wird.

Messen Sie oberhalb jeder Scrabe den Abstand zum Portal und verstellen Sie die H6he,
sodass Uber den gesamten Tisch die gleiche Héhe erhalten wird.

9.7 Kuhlmittelfullstandskontrolle

Der KuhImittelfullstand ist von wesentlicher Bedeutung. Wenn er nicht
hoch genug ist, kann nicht mehr ausreichend gekiihlt werden und das
Laserrohr kann beschadigt werden oder sogar explodieren. RegelmaRige
Fullstandskontrolle und regelmaRiges Beifllllen vermeidet diese Gefahr.

9.8 Uberpriifung der KithImittelfarbe

Die KuhImittelfarbe hangt vom Alter ab. Normalerweise ist das KuhImittel
hellblau. Ist es jedoch grinlich verfarbt, wird empfohlen, die Kiihlung
vollstandig zu entleeren und erneut mit Kiihimittel zu fullen. Dadurch wird
vermieden, dass Ablagerungen in der Leitung, im Rohr oder Kihler die
Lebensdauer negativ beeinflusst.
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10 Laser-Rohr-Anzeigewerte

80W Laser-Rohr-Anzeigewerte

CUTTING

Laser head type: standard laser head

materials thickness |speed|max power | power in corners

mdf 2.3 35 60 60

acr 5.0 12 60 60

acr 8.0 4 &0 &0

acr 10.0 3 60 60

acr 20.0 0.8 80 80

foam 17.0 10 [u] [u]

plywood 2.0 160 60 60

plywood 45 30 &0 &0

cardboard 6.0 60 60 60

non-dust cloth 1.0 300 33 33

leather 1.5 50 60 60

rubber 4.5 6 60 60

double color boards 1.5 40 60 60

bamboo 7.0 9 60 60

paper 0.2 300 60 60

Kraft paper 1.0 300 20 20

plastics f ! ! !

composite wood 7.0 10 &0 &0

granite / ! ! !

marble f ! ! !

ceramic cup f ! ! !

rostone ! ! ! !

anodized aluminum / ! ! !

grip tape / i i i

ENGRAVING

Laser head type: standard laser head

materials thickness |speed|max power min power scan ga

MDF ] 200 20 i 0.0

acr / 500 15 i 0.08

bamboo / 500 20 i 0.08

phywood / 500 13 i 0.08

cardboard I 500 15 i 0.08
paper / 500 13 ! 0.08
painted aluminum / 500 25 ! 0.08
chermy wood / 500 15 ! 0.08
anodized aluminum / 500 20 ! 0.08
plastaic I 500 18 ! 0.08
glass I 500 15 ! 0.08
Kraft paper / 500 18 I 0.08
leather / 500 15 ! 0.08
cloth i 500 13 [ 0.08
rubber / 500 30 15 0.06
W'Etal |r JI JI JI JI
double color boards / 500 15 ! 0.08
granite I 500 15 ! 0.08
marble / 500 40 ! 0.08
ceramic cup I 500 22 ! 0.08
rostone / 500 25 ! 0.08
grip tape I 500 18 ! 0.08
foam |r JI JI JI JI
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100W Laser-Rohr-Anzeigewerte

CUTTING

Laser head type: standard laser head

materials thickness |speed|max power | power in corners

mdf 25 50 60 60

acr 25 40 60 60

acr 5.0 16 60 60

acr 10.0 5 60 60

acr 200 1 60 60

Toam 17.0 8 [:10] (]

plywood 2.0 180 60 60

plywood 4.5 32 60 60

cardboard 2.0 150 a0 50

non-dust cloth 0.4 300 60 60

leather 1.5 60 60 60

rubber 4.0 8 60 60

double color boards 1.5 55 60 60

bamboo 7.0 13 60 60

paper 0.1 300 18 18

Kraft paper 0.5 300 40 40

cherry wood 15.0 3 &0 60

plastics / / / !

glass ! / f f

granite ! / ! !

marble / / ! !

ceramic cup ! / ! !

rostone / / ! !

anodized aluminum ! / ! !

grip tape / i i |

ENGRAVING

Laser head type: standard laser head

materials thickness |speed|max power min power scan gap |

MDF 500 20 [ 0.08

acr I 500 20 | 0.08

bamboo / 500 20 i 0.08

plywood I 500 20 | 0.08

cardboard / 500 20 i 0.08

paper / 500 14 i 0.08

painted aluminum / 500 30 i 0.08

cherry wood / 500 25 i 0.08

anodized aluminum / 500 30 i 0.08

plastaic / 500 20 i 0.08

glass / 500 25 i 0.08

Kraft paper / 500 20 i 0.08

leather / 500 20 i 0.08

cloth / 500 15 i 0.08

rubber / 500 40 15 0.06

metal / 500 i i 0.08

double color boards / 500 18 i 0.08

granite / 500 25 i 0.08

marble / 500 25 i 0.08

ceramic cup / 500 25 i 0.08

rostone / 5200 25 i 0.08

grip tape / 500 20 i 0.08

foam / ! ! i !
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130W Laser-Rohr-Anzeigewerte
CUTTING
Laser head type: standard laser head
materials thickness |[speed|max power | power in corners
mdf 25 35 60 650
mdf 3.8 15 60 60
mdf 10.0 25 60 650
acr 28 32 60 60
acr 5.0 15 60 650
acr 10.0 4 60 60
acr 200 1.5 60 60
Toam 17.0 11 [[y] 60
plywood 20 140 40 40
plywood 4.5 40 60 60
plywood 1.5 13 60 60
plywood 10.0 11 b0 b0
cardboard 6.0 22 50 50
non-dust cloth 0.4 250 60 650
leather 1.5 a0 60 60
rubber 4.5 9 60 60
double color boards 1.5 50 60 60
bamboo 7.0 12 60 60
paper 0.1 300 18 18
Kraft paper 0.5 300 40 40
cherry wood 15.0 3 60 650
plastics / / / !
glass | / ! f
granite / / / /
marble / / / !
CEeramic cup / / / /
rostone / / / /
anodized aluminum / / / !
grip tape / i i i/
MDF r 500 20 i 0.08
acr ! 500 20 ! 0.08
bamboo ! 500 20 ! 0.08
plywood i 500 20 i 0.08
cardboard r 500 20 i 0.08
paper f 500 14 i 0.08
painted aluminum f 500 30 i 0.08
cherry wood i 500 25 i 0.08
anodized aluminum ! 500 30 { 0.08
plastaic f 500 20 i 0.08
alass ! 500 25 ! 0.08
Kraft paper / 500 20 ! 0.08
leather i 500 20 i 0.08
cloth f 500 15 i 0.08
rubber f 500 40 15 0.06
metal r 500 ! i 0.08
double color boards ! 500 18 i 0.08
granite ! 500 25 { 0.08
marble r 500 25 f 0.08
Ceramic cup ! 500 25 i 0.08
rostone r 500 25 i 0.08
grip tape i 500 20 i 0.08
foam r i ! i/ !
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150W Laser-Rohr-Anzeigewerte
CUTTING
Laser head type: standard laser head
materials thickness |speed|max power | power in corners
midf 2.9 a0 60 60
midf 10.0 1 60 60
acr 3.0 40 60 60
acr 5.0 18 &0 650
acr 10.0 5 &0 650
acr 200 1 a0 90
foam 17.0 12 60 60
plywood 2.0 180 60 60
plywood 45 2b [:14] ]
plywood 100 45 &0 60
cardboard 7.0 a0 &0 650
non-dust cloth 0.4 300 60 60
leather 1.9 60 60 60
rubber 4.5 9 60 650
double color boards 1.5 50 60 60
bamboo 7.0 220 60 60
paper 0.1 300 15 15
Kraft paper 0.5 300 24 24
peach wood 18.0 1.5 60 60
peach wood 240 1 &0 60
cherry wood 10.0 6 60 60
plastics ! / / !
glass ! / / !
granite f J J f
marble ! / / !
ceramic cup ! / / !
rostone ! / / !
anodized aluminum ! / / !
grip tape i i i i
MDF ! 200 18 [ 0.08
acr ! 500 15 ! 0.08
bamboo / 500 15 ! 0.08
plywood / 500 15 ! 0.08
cardboard / 500 13 ! 0.08
paper / 500 12 ! 0.08
painted aluminum / 400 25 ! 0.08
cherry wood / 500 15 ! 0.08
anodized aluminum ! 400 18 ! 0.08
plastaic / 500 15 ! 0.08
glass ! 300 20 ! 0.08
Kraft paper / 500 15 ! 0.08
leather / 500 15 ! 0.08
cloth ! 500 12 ! 0.08
rubber ! 300 20 12 0.06
metal / i ! ! 0.08
double color boards / 500 15 ! 0.08
granite / 450 25 ! 0.08
marble ! 450 22 ! 0.08
ceramic cup / 450 25 ! 0.08
rostone ! 450 25 ! 0.08
grip tape ! 500 15 ! 0.08
foam lr JI JI JI JI
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11 Demontage und Entsorgung

Bei der Demontage der Maschine kdnnen die Metall- und Kunststoffteile ohne zusatzliche
Malinahmen zu einer geeigneten Stelle abgefihrt werden.
Die Demontage muss von befugten Personen ausgefiihrt werden.
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12 Technische Daten

12.1 Elektrisch
Netzanschluss 230V~ 50/60Hz 1 Phase geerdet
Leistungsabnahme 2,5kW

Sicherung: eingebauter Sicherungsautomat 8A

Ausgang: 2x 230V~ 50/60Hz 1 Phase geerdet Steckdose 4A je Steckdose
12.2 Mechanisch

Gewicht: 400kg

Abmessung. Breite/Hohe/Tiefe 1900/1050/1420 mm

12.3 Umgebung
Maximale

Umgebungstemperatur. 30°C

12.4 Software

Softwareunterstitzende Dateiformate:
Vektorformat: dxf, ai, plt, dst, dsb...etc.
Bitmapformat: bmp, jpg, gif, png, mng,...etc.
Formatspeicherung: RLD, RD
Formatexport: Al

12.5 Systemanforderungen

- Windows XP oder héher, Windows 10 empfohlen. Mac wird nicht unterstitzt
- héher als CPU586, hdher als Pentium Il oder Pentium IV empfohlen

- Speicher: mehr als 1 GB empfohlen
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13 Anlagen

13.1 EG — Konformitatserklarung CO; Laser
13.2 EG - Konformitatserklarung Stromversorgung des Lasers
13.3 Elektroschaltplan

13.4 EG - Konformitatserklarung Laserschneidemaschine
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13.1 EG - Konformitatserklarung CO2 Laser

Attestation of Compliance

No. 0T121105/BEL 1659

Certificate’s Holder: Beijing EFR Laser S & T Co.,Ltd.
#6208, No. 6, Fanghezhengyuan Industrial Park,
Zhangjiawan Industrial Development Zone, Tongzhou
District, Beijing, China

Product: CO; Laser

Model(s): ZN-1050, ZN-1250, ZN-1450, ZN-1650,
ZN-1850, ZN-2050, FO, F2, F4, F6, F8, F10,
PS-N80, PS-N100, PS-N150

Directives: 2006/95/EC Low Voltage
2004/108/EC Electromagnetic Compatibility

Standards: EN 60825-1:2007, EN 61000-6-1:2007,
EN 61000-6-3:2007+A1:2011

-
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Remark: This document has been issued upon a review of the datasheets and of the Technical
Construction File. The apparatus is considered to meet the requirements of the above standards,
therefore to fulfil the requirements of the above listed Directives.

This Document is only valid for the equipment and configuration described and in conjunction with the
test data detailed above. Nevertheless the Manufacturer is not exempted to perform all the necessary
activities before issuing the Declaration of Conformity. In case the appliance is modified or the appliance
will be equipped with Accessories not specified in the Manufacturer Operator Manual. it is recommended
to get in touch with Ente Cerlificazione Macchine for EC validity extension.

A

Expiry date 04/11/2017

Ente Certificazione Macchine S.R.L.

Via Mincio,386 - 41056 Savignano s/P. (MO) - ITALY -
2 420 NRA 7RT7IR +20 NRA 7TARZNA = +30 NRA TR1R3R 57 infn@Mentararma it O www antacarma it

Certificate — CepTudukar —
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13.2 EG - Konformitatserklarung Stromversorqgung des Lasers

Attestation of Compliance

No. 0T121120/BEL1749

Certificate’s Holder: Beijing EFR Laser S&T Co.,Ltd.
#6208, No. 6, Fanghezhengyuan Industrial Park,
Zhangjiawan Industrial Development Zone, Tongzhou
District, Beijing, China

Product: Power Supply

Model(s):

Directives:

Standards: EN 60825-1:2007

EN 61000-6-1:2007
EN 61000-6-3:2007+A1:2011 s
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Construction File./The ap us is considered to meet the requi s offthe aboVe standards,
of the above listed Directives.

e equipment and configuration d&nbod l

This Document is only valid fof
test data detailed above. Neve

ertificate — Ceptudukar —

Ente Certificazione Macchine S.R.L.
Via Mincio,386 - 41056 Savngnano slP (MO) ITALY -

—~  Am e~ —an—— an Ama ma~an~—
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13.3 Elektroschaltplan
Zusatzliche Schaltplane sind auf Anfrage lieferbar.
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Bedienungsanleitung Laserschneidmaschine BRM 90130 Version 2

13.4 EG — Konformitatserklarung

CINVUILASERS

brmlasers.com

EG-KONFORMITATSERKLARUNG FUR MASCHINEN
(konform mit Anlage Il (1) Unterpunkt A der Maschinenrichtlinie 2006/42/EG)

Importeur/Hersteller: BRM Lasers
Stral3e: Ambachtsstraat 43
NL-7102 DW Winterswijk

erklart hiermit, dass:

Maschinentyp: Laserschneidmaschine BRM 90130
Maschinennummer: 91513909201

- die Maschine allen einschlagigen Bestimmungen der Maschinenrichtlinie (Richtlinie
2006/42/EG, letzte Fassung) entspricht und die Nationalen Gesetzgebung zur
Ausflihrung dieser Richtlinie entspricht

- den Bestimmungen der EMV - Richtlinie (2004/108/EG).

und dass u.a. die nachfolgende (Ausschnitte von) harmonisierten Normen angewendet
wurden:

- EN 12100:2010, EN 60204-1:2006+A1:2009, EN 60825-1:2014: EN 61000-6-1:2007,
EN 6100-6-3:2007, EN 12978:2003+A1:2009

Unterzeichnet in: Winterswijk, Datum

Name:
Funktion:
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